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The Program

ChemEQL, insinuating ‘Chemical Equilibrium’, calculates and draws thermodynamic equilibrium
concentrations of species in complex chemical systems. It handles homogeneous solutions,
dissolution, precipitation, titration with acid or other components. Adsorption on up to five different
particulate surfaces can be calculated with the choice of the Constant Capacitance, Diffuse Layer
(Generalized Two Layer), Basic Stern Layer, or Triple Layer model to consider for surface charges.
Corrections for ionic strength can be made and activities calculated. One rate determining process in a
system of otherwise fast thermodynamic chemical equilibrium can be simulated. Two-dimensional
logarithmic diagrams, such as pe-pH, can be calculated. A simple drawing option is provided. A library
with over 1700 thermodynamic stability constants allows quick access and easy use of the program.

Another library with more than 300 solubility constants allows easy introduction of solid phases.

The present application was developed starting out from the original program MICROQL in BASIC by
John Westall. The basic principles of the calculation method is documented by J. Westall, "Chemical
Equilibrium Including Adsorption on Charged Surfaces", Advances in Chemistry Series, no. 189,
Particulates in water, ed. by M.C. Kavanaugh and J.O. Leckie, 1980, and J. Westall, J.L. Zachary and F.
Morel, "MINEQL, a Computer Program for the Calculation of Chemical Equilibrium Composition of

Aqueous Systems", Technical Note no. 18, Ralph M. Parsons Lab. MIT, Cambridge, 1976.

Kai-H. Brassel (www.vseit.de) implemented this program in Java code. Independent from whether you

work under Windows, Linux, Solaris or MacOS X (for older operating systems there exists a Pascal-

version of ChemEQL) the application can be downloaded from

http://www.eawag.ch/research/surf/forschung/chemeql.html

By clicking on the ChemEQL icon the application is downloaded, installed on your hard disc, and
started. Installation is made independent from your operating system directly from the internet browser
through the WebStart-plugin from Sun Microsystems Inc. (www.sun.com). WebStart cares for the
installation of a suitable Java runtime environment in case it is not available, and for the automatic

installation of new versions of ChemEQL. In case WebStart is not yet installed or part of the operating
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system (as in MacOS X) WebStart will be installed automatically as Browser-Plugin first from the Java
WebStart setup page of Sun Microsystems, Inc. The installation is a one-time process. The ChemEQL

application launched with Java WebStart is cached locally on your hard disk and works off-line.

A manual can be downloaded that intends to be a practical guide through most options the program

offers. | believe that providing examples makes it easier to pick things up that explaining theory.

Kastanienbaum, June 21, 2004 Beat Muller
e-mail: beat.mueller@eawag.ch

Fax: ++ 41 41 349 21 68
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Jump Start

Set up a matrix

Putting up a matrix by hand is a source of many mistakes and sometimes it is quite a task to find
species, reactions, and stability constants. Two libraries are provided for the users comfort, one
containing complex formation constants and the other solubility products. Both libraries are
automatically downloaded, digitalized and stored in the users home account. At startup, the program
checks the availability of the users libraries. In case they are missing, changed names, or were deleted
the program reloads the libraries again. Hence, you are not bothered by the installation or preparation

of the libraries.

Starting the ChemEQL application you will find the Access Library... item under the File menu.

The following window will appear:

Select Compaonents
ChemEQL Library Matrix Selection
Ag+ r
Al+++
Ba++
Be++
Ca++
Cd++ Mode:
Co++
Co+++
Cr++4
Cr+++
Cs+
Cu+
Cu++
Fe++
Fed++
Cat+++
Hg++
Hg2++
CH3Hg+
vV

Concentration:

Cancel

In the list to the left you see the content of the library components, the list to the right is now empty and
will show the components that you have selected. Activate a component by mouse click, enter its
concentration, choose the mode (either 'total' to indicate that the number means the total
concentration of that component in your system, or 'free' if the input refers to the concentration of the

individual species selected, e.g. pH. In the latter case the free concentration of this species will be held
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constant). Clicking the '>>Add>>' button (or CR) will remove the selected component from the library
and transfer it to your selection. If you wish to remove a component from your selection, activate it and
press the now active 's<<Remove<<' button. The component will be removed from the selection and

added at the end of the library list.

As an example we want to perform some pH and concentration calculations with diluted acetic acid: In
order to select the matrix for the acetic acid system (which we will put up in detail with much effort on
pages 29-31), select 'AceticAcid' from the library, enter '1e-3' for concentration, and press the
'Add' button. Proceed to the end of the library list, select 'H+', enter '1e-4' for the concentration,
choose 'free' (since we want to calculate for constant pH), and press again the 'Add' button. This is
the whole selection needed. Pressing 'compile matrix' will end the library dialog. The program will
search the library for all possible combinations of the chosen components and will list them as species.
(There is no guarantee for completeness!). The following window will appear and show the
components you selected with the concentration and mode, and all species that were found in the

library with the attached formation constants.

006 New Matrix
AceticAcid H+
total free
1.000E-3 1.000E-4

-> pH is constant: 4.000

1. Hac 0.00
2. Ac- -4,73725,00
3.0H- -14.00
4. H+ 0.00

If you wish to use this matrix again make sure to save it: Choose Save Matrix... from the File menu!
Run and Go will calculate the speciation of that system: What are the concentrations of HAc and Ac- in

a solution of pH 47?
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eo0e Data
Species Stoich. M Log K Conc. [mol/l] Log conc.
Hac 10 0.00 8.430E-4 -3.07
Ac- 1-1 -4.73 1.570E-4 -3.80
OH- 0-1 -14.00 1.000E-10 -10.00
H+ 01 0.00 1.000E-4 -4.00
Components Mode Initial Conc. In or out of system
AceticAcid total 1.000E-3 ———-
H+ free 1.000E-4 -5.698E-5

The upper part of the data window lists the species, the stoichiometric matrix, the formation
constants used, the equilibrium concentrations and their logarithms. The lower part
describes the components (which must be in the species list as well), their mode and initial
concentration. The 'in or out of system' column gives the amount (per liter) of a component that
had to be added to or taken away from a system in order to keep its free concentration constant during
a process. In this example the value of '-5.698e-5' means that this concentration of H* had to be
neutralized in the system (taken out) in order to keep up a pH of 4 when preparing a solution of 10°M

acetic acid.

Insert solid phases

Setting up a matrix to calculate dissolution of a solid phase (with an unlimited concentration) or to check
whether precipitation of a solid phase occurs from a solution of a certain composition (limited

concentration) takes two steps:

1% Create a matrix from the library containing the metal ion(s) and the ligand(s), which together form
the solid phase, eg. if we want to investigate dissolution of CaCQO; (Calcite) in pure water select

the components ‘Ca++’, ‘CO3--‘ and ‘H+":
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(The concentration of the cation is of no importance and will be set to 1 later automatically when

transformed into solid phases.)

2"? The next steps are to replace 'Ca++' by Calcite. This is done with the help of the solid phases

(@06 New Matrix |
Ca++ C03-- H+
total total total
1.000E-3 0.0 0.0
1. Ca++ 0.00
2. CaOH+ -12.78°25,0° St&Mo
3. CaCO3(aq) 3.22 725,00 St&Mo
4, CaHCO3+ 11.44 "25,0° St&Mo
5.H2C03 16.68 "25,0° S&M
6. HCO3- 10.33 "25,0" S&M
7.C03-- 0.00
8. 0OH- -14.00
9. H+ 0.00
i

library. It is accessed with the item Insert Solid Phases... from the Matrix menu. (To change

or extend this library see next chapter):

The following window will appear:

re MmN

Replace Ca++

Options Run

Replace H+ by OH-
Delete Species ...

Insert Solid Phase ...

Insert Solid Phase

logKso

with | Ag(0)s)

0.7996

Handbook

Ag+ + e- <==> Agl0l}s)

( Cancel ) E—H
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Now replace 'Ca++' with CaCO;, (Calcite) by scrolling down the pop up menu ‘with’. The current

matrix will be recalculated for the solid phase to:

'6 06 New Matrix
CaCo03 (Calcite) CO3-- H+
solidPhase total total
1.0 0.0 0.0
1. Ca++ -8.48
2. CaOH+ -21.26 25,07 St&Mo
3. CaCO3(ag) -5.26 725,07 St&Mo
4. CaHCO3+ 2.96 25,07 St&Mo
5.H2C03 16.68 "25,0" S&M
6. HCO3- 10.33 725,07 S&M
7.C03-—- 0.00
8. OH- -14.00
9. H+ 0.00

As you can see, the mode is now ‘solidPhase’, and the activity is set =1 as defined for solid phases.

Starting the calculation will lead to the composition of the system where calcite is in equilibrium with

pure water. In order to reach this equilibrium 1.16:10* mol calcite were dissolved per liter of solution.

(@06 Data
Species Stoich. Matri Log K Conc. [mal/l] Log conc.
Ca++ 1-10 -8.48 1.101E-4 -3.96
CaOH+ 1-1-1 -21.26 1.465E-7 -6.83
CaCO3(aq) 100 -5.26 5.495E-6 -5.26
CaHCO3+ 101 2.96 1.137E-7 -6.94
H2CO03 012 16.68 2.23BE-8 -7.65
HCO3- 011 10.33 8.017E-5 -4.10
C03-- 010 0.00 3.007E-5 -4.52
OH- 00-1 -14.00 8.019E-5 -4.10
H+ 001 0.00 1.247E-10 -9.90
Components Mode Initial Conc. In or out of system
CaCO3 (Calcite) solidPhase unlimited 1.159E-4
C03-- total 0.0 ———
H+ total —— —
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Check for precipitation

A different task is to check whether calcite precipitates from a solution of a certain composition, e.g. 10°

¥ mol/l Ca* and 10 mol/l CO4* at pH 8. The same matrix can be used changing the modes of calcite

from solidPhase to checkPrecip and entering the concentration of total dissolved Ca (the sum of

all dissolved Ca species), total dissolved carbonate (the sum of all carbon species) and fixed pH. All

these changes can be entered interactively in the matrix window: The matrix should then look the

following way:

eoe

LR NS W

H+

The result window shows that such a solution is oversaturated with respect to calcite: 1.38:10* mol of

CaCoO3 (Calcite)
checkPrecip
1.000E-3

-> pH is constant: 8.

.Ca++
CaOH+

. CaCO3(aq)
.CaHCO3+
H2C03
HCO3-
CO3--
OH-

New Matrix

CcC03--
total
1.000E-5

000

-B.48

H+
free
1.000E-8

-21.26 725,07 5t&Mo

-5.26725,0° 5t&Mo

2.96 725,07 St&Mo
16.68 725,07 S&M
10.33 725,07 5&M

0.00
-14.00
0.00

calcite was precipitated from one liter of solution (also under ‘in or out of system’), and the composition

of the solution is given:

'®@06

CaC0O3 (Calcite)-precipitation: 0.000138

Species
Ca++
CaOH+
CaCO3({aq)
CaHCO3+
H2CO3
HCO3-
Cc03--
OH-
H+

Components
CaCO03 (Calcite)
co3--
H+

Data
Stoich. Matri Log K Conc. [maol/l]
1-10 -8.48 8.477E-4
1-1-1 -21.26 1.407E-8
100 -5.26 5.495E-6
101 2.96 9.120E-6
012 16.68 1.870E-5
011 10.33 8.351E-4
010 0.00 3.906E-6
00-1 -14.00 1.000E-6
001 0.00 1.000E-8
Mode Initial Conc.
checkPrecip  unlimited
total 1.000E-5 ———=
free 1.000E-8

Log conc.

In or out of system

-1.377E-4

8.806E-4
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Several solid phases

The procedure is the same as in the former case. Set up a matrix from the library that contains the
cation and all the ligands that will occur in the solid phases. In a second step, the solid phases will be

introduced from the solid phase library.

Example: What is the solubility of CaSO4(s) and CaH2SiO4(s) in pure water.

Procedure: Select Ca++, SO4--, H4SiO4, and H+ from the library to obtain the following

matrix:

(@06 New Matrix |
Ca++ 504-- H45i04(aq) H+
total total total total

0.0 0.0 0.0 0.0
1. Ca++ 0.00
2. CaOH+ -12.78725,07 St&Mo
3. CasS04 2.31725,070 &M
4. CaH25i04(aq) -19.90 "25,0° S&M
5. CaH3Si04+ -9,50 725,07 5&M
6. Ca(H35i04)2(aq) -16.90 725,07 5&M
7. HSIi04--- -32.85 Grenthe
8.504-- 0.00
9. HS04- 1.99 "25,0° 5&M
10. H25i04-- -23.00
11. H35i04- -9.,90 "25,0" &M
12. H4Si04(aq) (Si02) 0.00 "25,0°" &M
13. H2(5i04)2-- -19.40 M
14, H4({Si04)4---- -36.10 725,07 S&M
15. HB(SiI04)4-- -13.80 725,07 5&M
16. OH- -14.00
17. H+ 0.00

(The concentration for Ca++ is irrelevant and will be set to 1 automatically when solid phases are

introduced). Solid phases can now be inserted. Firstly, H4SiO4(aq) is replaced with CaH2SiO4(s)

F — N

enon Insert Solid Phase

Replace H45i04(aq) T] &
-14.9

with  CaH2Si04 (s) =1

Ca++ + H45i04(ag) <==> 2H+ + CaH25i04 (s)

(" Cancel ) ( Ok }
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The order in which the solid phases are inserted is not important. We could have replaced SO4-- by

CaS04(s) first as well. However, the ligand components have to be replaced first, and

the metal component last! Now we replace Ca++ by CaS0O4 (Anhydrite):

r

® 00

Replace

Ca++

Insert Solid Phase

logKso

with  CaS04 (Anhydrite)

Ca++ + SO4--

[ Cancel )

4.36

"25,0" St&NMo

==> CaS04 (Anhydrite)

ok )

The following matrix is obtained with new stoichiometric coefficients and recalculated complexation

constants:

806
Cas04 (Anhydrite)

[FaJ - BN o T, R S TR S )

solidPhase
1.0

.Ca++
.CaDH+

CaS04

. CaH25i04(aq)
. CaH35i04+
. Ca(H35i04)2(aq)

HSi04---
S04--

.H504-
.H25i04--

. H35i04-

- H45i04(aq) (Si02)
.H2(5i04)2--
.H4(5104)4----

. HB(5i04)4--
.OH-

.H+

Mew Matrix

CaH2S5i04 (s) H+
solidPhase

SO4--
total
0.0

-4.36
-17.14 250" St&Mo
-2.05 725,07 S&M
-5.00 725,07 S&M
5.40°25,0" 5&M
17.26 725,07 5&M
-13.59 Crenthe
0.00
1.99 25,07 S&M
-3.74
9,36 725,07 S&M
19.26 "25,0" 5&M
19.12 M
40.94 "25,0" S&M
£3.24 "25,0" S&M
-14.00
0.00

total
0.0

The result of the calculation shows that CaSO, (Anhydrite) is more soluble than CaH,SiO, since

1.53-10"2 moles of Anhydrite per liter were dissolved, and only 4.35-104 moles of calcium silicate:
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‘806 Data
Species Stoich. Matrix Log K Conc. [molfl] Log conc.
Ca++ 1-100 -4.36 6.795E-3 -2.17
CaOH+ 1-10-1 -17.14 4 808E-5 -4.32
CaS04 1000 -2.05 8.913E-3 -2.05
CaH2Si04(aq) 0010 -5.00 1.000E-5 -5.00
CaH3Si04+ 0011 5.40 5.891E-6 -5.23
Ca(H35i04)2(aq) -1122 17.26 6.430E-7 -6.19
HSiO4--- -111-1 -13.59 7.041E-6 -5.15
504 -- 0100 0.00 6.424E-3 -2.19
HSO4- 0101 1.99 1.472E-11 -10.83
H2Si04-- -1110 -3.74 1.169E-6 -5.93
H3Si04- -1111 9.36 3.451E-4 -3.46
H4Si04({aq) (5i02) -1112 19.26 6.430E-5 -4.19
H2(Si04)2-- -2222 19.12 2.992E-7 -6.52
H4(Si04)4---- -4 4 4 4 40.94 4488E-11 -10.35
H6(Si04)4-- -4 4 4 6 63.24 4925E-10 -9.31
OH- 000-1 -14.00 4.264E-4 -3.37
H+ 0001 0.00 2.345E-11 -10.63
Components Mode Initial Conc. In or out of system
CaS04 (Anhydrite) solidPhase unlimited 1.534E-2
504 -- total 0.0 e
CaH25i04 (s) solidPhase unlimited 4.354E-4
H+ total ———> e

Access the libraries

You can add your own components, species and complex formation constants to the existing libraries,
delete species and components or change their names and constants. All facilities needed are given

in the Libraries menu:

£ @'_z ChemEQL FiIeMatrix Options Run

‘@006 Edit Regular Lib. Components ...
Edit Regular Lib. Species ...

ChemEQL

Edit Solid Phases Lib. Components ...

Edit Solid Phases Lib. Species ...

The Regular Library contains mass action laws and formation constants of dissolved species, the

Solid Phases Library solubility products. Access to the solid phases library is organized in
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precisely the same way as for the regular library, hence, only the management of the Regular Library

will be presented here.

Edit Regular Library Components

This dialog handles the insertion of new components or the deletion of components in the

regular Library. Component names can be changed as well here:

ene Edit Components (Regular Library)
Component Selection Edit Mame

Ag+ Ca++
Al+++ m

Ba++

Be++

lca++ |

Cd++ ; i

¢ Insert new Component before )

Co++ . b
Co+++

Reset Accept

Cr++ I Delete Component 3
Cr+++

Cs+

[ Cancel ) Save & Exit

New components are entered after pressing the ‘Insert new component before’ bar. Place the

new component alphabetically in the library. E.g. insertion of Pu®* is made in the following way:

Edit Components (Regular Library)
Component Selection Edit Mame

Na+ Rb+

Reset Accept

R+ 800 ChemEQL 1ponent before

Sr++ ' Name of new component? imponent
Ti+++ M Pu+++

I Cancel I ( OK )
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Prevent an inflation of new components! Check if the formation of a new species possibly can be
written with an already existing component, e.g. with SO4-- instead of HSO4-. New components do

not need to be introduced as species explicitly. This is done automatically.

Edit Regular Library Species

The next dialog gives access to the names of species, their binding constants and literature.
Always use the FORMATION constant of the species! The top right gray field lists the mass action

law for which the binding constant is valid:

r@ &) ) Edit Species (Regular Library)

Species Selection
CaHMurexid Ca++ + HCO3- <==> H+ + CaCO3(ag)

CaMoO4

CaMurexid- C] ] =i
CaOH+ CaC0O3(aq)

CaCO3(ag)

CaCO3(ag) log K: -7.11

CaCO3(ag) Literatur: "25,0" St&Mo
CaHCO3+
CaHCO3+
CaHCO3+
CaF+
CalO3+ -
CaNO3+ ( New Species
Ca(NO3)2

CaNH3++ ( Delete Species
CalNH3)2++
CaNH3++

T

Reset | | Accepl"

(" Cancel ) ( Save & Exit )

Species can be deleted. New species can be inserted with their mass action law, complex formation
constant, Literature including temperature and ionic strength where they are valid, by pressing the
‘New Species’ bar. To insert a new species, e.g. CaJO;*, write its name in the first field. This name
will appear on the product side in the gray text field below showing the mass action law. Then write its
FORMATION equation using the popup menu with all the components offered from the
respective library. Select an educt or product component and direct it to the educt or product side of

the mass law equation shown in the gray field below with the respective buttons. The 'Lit.' field takes
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notes for temperature, ionic strength and literature references but can remain empty. To be compatible

with the present style write ““Temp,ionic strength” Lit’. New species are added in alphabetical

order starting from the beginning of the library.

The regular library at present contains data of more than 100 components and more than 1700

species. The solid phases-library holds 68 components and more than 300 species.

e Create New Species
New Species:.Ca,JO3+

LogK: 0.89  Literatur: 0" Smith&Martell 76

Coeff.. 1 JO3- =

[ 4+ educt | ([ + product )

Ca++ ===> C(Ca/03+

| Cancel ) (Insen}
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Exchange the libraries

Library files can be altered or extended and exported and exchanged with colleagues: export your

library to create an EXCEL text files again with the menu command Export Library...

This file format can be again imported to ChemEQL using the File menu item Import Library...



ChemEQL Manual 20

r

é ChemEQL m Libraries Matrix Options Run
806 Open Matrix ... ®0
Access Library ... ##/L

Save Matrix ...
Save Data ... £

Import Library ...

Export Library ...

Print Selected Window ...

Settings ...
Iteration Parameters ...

Select CQLJ.RegularLib and save it with the following window as ‘Regular Library’:

"o00 ChemEQL )
' Sawve Library as:
.
Solid Phases Library Regular Library

The same procedure is then repeated with the solid phase library. The imported files are automatically
saved as binary files. Names must not be changed otherwise ChemEQL does not recognize the

libraries and reloads the standard libraries from the ChemEQL homepage.

Settings

The Settings... window allows selection of the number of decimal places displayed in the matrix and

results windows:

i YeXe Settings

Define number of decimal places!

Concentrations: 0.000EQ B:
Constants: | 0.00 B:

(:Cancel_\) E Ok 3
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Iteration parameters

In case of non-convergence the calculation is stopped after 50 iterations. This number is very
appropriate and does not need to be changed. In case an iteration does not converge the problem is

usually an error in the matrix, see chapter ‘lteration does not converge’.

r = -

enn lteration parameters
Maximum number of iterations: | 50|

Convergence criteria: 1.0E-6
"1 Change convergence criteria automatically, write " 1"

Write "*" for each iteration

[ Cancel )

For some tricky calculations of titration curves or large arrays of concentrations it may occur that an
iteration error appears occasionally even though the matrix is correct, i.e. chemically sensible. Ticking
the box you arrange that the convergence criteria is lowered by a factor of 10 and a ‘Y’ is written to
remind you that the result is questionable. The convergence criteria is setback to the original value for

the following calculation automatically.

The number of iterations used in a calculation can be indicated by “*’ printed with the results.

Activity

Using the Activity option will calculate speciation in activities instead of concentrations. This is of

importance particularly in solutions with high ionic strengths.
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Kinetics ...
pX-pY Diagram ...

Format

¥ no

Graphics ... - Debye-Hiickel ...
Gintelberg ...
Davies ...

Info ...

To use this option make sure that all complex formation constants are valid for an
ionic strength of 0, and that charges of all components and species are included in
their names as '+' or '-', e.g. 'PO4---' or 'Fe++', etc. The 'Info' window provides you with the

basic knowledge for the option:

8eOn0n Activity Info [

These options correct your log K values (which must be valid for 1=0) for the ionic
strength.

. =

The activities of all species are divided by the activity-term calculated according to
one of the offered approximations, and new log K are calculated accordingly.

Mixed constants are used according to IUPAC convention. Therefore the ion product
of water is defined as K={H+}[OH-].

Conditions: - All log K values in the matrix must be valid for [=0.

- All charges of species and components must appear in their names
in the matrix as '+' or -' characters, eq. "HCO3-", "Ca++", "PO4—"

Debye-Hlckel-approximation: for [<0.005M
Gintelberg-approximation: for [<0.1M, useful in solutions of several electrolytes.

Davies-approximation: for [<0.6M (const=0.2)

o)

A

Choosing either Debye-Hiickel, Giintelberg or Davies approximation from the Activity menu

will lead to the following dialog:
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r . -
6 Activity
) lonic strength | =
® Calculate ionic strength according to matrix

A = 1.82E6 (eT)-3/2 = 0.5

) concentrations

Give output in: o
® activities

( Cancel ) (Actept}

You can enter the concentration of an electrolyte that is not necessarily contained in the matrix by
selecting 'lonic strength'. The alternative choice is that you make the program calculate the ionic
strength according to the species and concentrations of your matrix. The program will then include in
the iterative procedure the calculation of the ionic strength with the calculated concentrations and

charges found in the names of the species.

Activity coefficients are then calculated according to the selected method, and stability constants for
the formation of each species corrected for the new activity coefficients. The iteration proceeds until a
convergence criteria is fulfilled. If the condition cannot be satisfied after a certain number of cycles a
message window will appear and the program will leave the cycle. This case usually occurs if the ionic
strength is unreasonably high. (A is a constant used to calculate activity coefficients and is =0.5 in

water of 25 degrees.)

Therefore the speciation calculation is performed with respect to activities. The choice between
‘concentrations' and 'activities' concerns only the output values: The results can be given either in
concentrations with the dimension [mol / liter], or, multiplied with the calculated activity coefficient for
the respective species, in dimensionless activities. Graphics are drawn in activities. (Activities will

appear in italic on the datasheet).
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Array of concentrations

A matrix can be calculated for a pH range (choose pH range... in the Options menu) or a

concentration range of any component of the matrix (choose Component Range... in the

Options menu. However, it can be calculated for any arrangement of concentrations at once

(e.g. for various conditions in an experiment). In order to do this, write additional concentrations below

the ‘ordinary’ concentration line of the matrix. This must be done in EXCEL, however. The program will

check if there are several more concentrations to calculate or just one. The final matrix may look as

follows (This matrix is in the set of examples as 'Pb.mat'):

In the current matrix window you will find the remark, that the calculation will be performed for an

array of concentrations.

eoce

Pb++

PBOH+
PBCOHY 2 (ag)
Pb{OH}3-
PbZOH+++
Ph3E0OHY 4+ +
PhaiOHY 4+ +4
PRELOHIG++4
OH-

H+

Pb+
total

+

DD L W P = = — =

1.00E-04
3.00E-04
1.00E-06
2.00E-05
2.00E-04

H+
total
0
-1
-2
-3
-1
-4
-4
-8
-1
1
0.00E+00
0.00E+00
2.00E-04
1.00E-03
0.00E+00

-1.7
-17.1
-28.1
-6.4
-23.9
-z0.9
-436
-14
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Graphic representation

In case of calculating for an array of concentrations or a pH range you have the choice of plotting the

results graphically. However, the species to be plotted must be chosen before the calculation is

started. Choose Graphics... from the Options menu.

® O O Graphics
Select species for graph:

PO4-—-
HPO4--
H2PO4-
H3PO4
OH-
H+

( Draw }

(_ Defaults |

The plot window will be the front window, all data will be printed on a second window behind which can

be saved after calculation:

laXaXal

Data

PO4——- HPO4——
1.249E-24 1.249E-12
4.950E-24 3.123E-12

EXeXs)

H2PD4-
7.881E-6
1.243E-5

H3PO4 OH-
9.921E-4 1.000E-14
9.876E-4 1.585E-14

Craphics

~log H+
-0.000 ’\
0.200

10E-3T +

9.0E-44

B.0E-4+

7.0E-44

6.0E-4

5.0E-44

[fj0W] UoesUBIUDD

4.0E-4

3.0E-44

2.0E-4+

1.0E-4

00E0 x5

0.00 100 2.00

e

3.00

4.00

s00ve00 .
00 °q « POd—

x H2PO4-
+ H3PO4

° o
o2 x . 2o
5.00 900 1000 1100 1200

6.00 7.00

pH range

8.00 13.00 14.00 :
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Linear / Logarithmic data format

Data output format (linear or logarithmic) can be selected from the Options menu:

Run

Change pH ...

pH range ...
Component range ...
Adsorption range ...
log K range ...

Kinetics ...

pX-pY Diagram ...

Activity >

Graphics ... ®D

Restore #R EO,L

Format L v Linear

Accordingly, the data format as well as graphic plots will be given according to selection. However, the

format must be selected before the calculation is started:

000 Data

PO4-—- HPO4-— H2PO4- H3PO4 OH- ~log H+
-23.903 -11.903 -5.103 -3.003 -14.000 -0.000
-23.305 -11.505 -4.905 -3.005 -13.800 0.200

afa)é) Graphics

« POd—

o HPO4—
x H2PO4-

+ H3PC4

too 1bo  zbo  3bo  ab0  sbo  ebo 7ho  sdo
pHrange
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Replace H* by OH

This is a very helpful option if instead of H*, OH" is needed as a component in case one wants to add
OH- to a solution or titrate an acid with a base, i.e. OH". Apply this command to your matrix, and all
complexation constants are adjusted for OH" instead of H*: The function recalculates all

binding constants using the ion product of water given in the matrix.

[©® O © Matrix AceticAcid.cgl (/... "® O O Matrix AceticAcid.cql (/...
HAC H+ HAC OH-
total total total total

1.000E-3 0.0 1.000E-3 0.0
1. Hac 0.00 > 1. Hac 0.00
2. Ac- -4.73 2. Ac- 9.27
3. OH- ~14.00 3. H+ -14.00
4. H+ 0.00 4. OH- 0.00

If OH" is a component of the matrix, the command changes to ‘Replace OH- by H+’.
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Iteration does not converge

For some large matrixes it can occur that the calculation does not converge. However, this message
usually appears if some fundamental mistakes were made in the matrix: The matrix does not
make sense chemically, components do not appear as species, concentrations are entered as zero,
stoichiometric coefficients are wrong, false binding constants lead to impossible numbers in the pursuit

of the calculation etc. In this case the following window will appear:

e ChemEQL: Iterations do not converge!

Check concentrations and constants for plausible values
and make sure all components appear as species.

The criteria of 1.0E-6 can be changed tol.0E-5
(Data are not reliable if the criteria is > le-5)

Abort ( Doit )

If you allow the program to be more tolerant with its convergence criteria by clicking do it you will find
that the calculation converges immediately afterwards in case your matrix is ok. The results should be
reliable. If the calculation does not converge, however, your matrix most probably contains a major

mistake and the calculation it will not converge until the criteria is very large.

Never trust any data if the calculation does not converge immediately after the first warning!
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How to set up a Matrix — The Details

The computer-compatible formulation of chemical reactions is designed in a matrix format. To describe
the species of interest (e.g. for acetic acid: HAc, Ac’), a minimum number of independent
components are chosen (e.g. HAc and H*, or Ac’ and H*, or Ac and OH'"...) such that the formation
of all species can be written with chemical mass action laws as the products of the components and
binding constants. (no. of components = no. of species minus no. of independent reactions). The
stoichiometric coefficients of the components whose reactions form the species of interest appear in
the matrix; the components stand in the columns, the species in the lines of the matrix. The
equilibrium constants are added in an additional column. The matrices must be saved as EXCEL-text

files. The extension “.cql’ is recognized by the program as a ChemEQL file.

A simple example of a matrix is the following:

names of components o )
stoichiometric

modes coefficients
/
AN \B | € | p/]
1 "HAC H+
2 tolaf todal
names of 3 |Hac 1 0 0
species ———| AC— 1 -1 -4.73
5 |OH- 0 -1 -1 4\
6 |H+ 1] 1 0 Sformation
¥ 1.00E-3 0.oo constants
concentrations
Important!
. The only condition with respect to the sequence of the components is to put H* in the

last column and in the last line of the matrix.

. Each component must also appear as a species in the matrix (with log K=0),
except solid phases or surface charges.

. Write the charges of species and components as a number of '+' or '-' characters in the
names, e.g. Pb++, PO4--- (imperative only for activity corrections).



ChemEQL Manual 30

The mode codes for the matrix:

The characterization (or mode) of the components which is given by the chemical question (eg. this
component is a solid phase, the concentration of this component remains constant, this is a particulate

surface...) is introduced in the second line of the matrix by the following codes:

Dissolved
'total’ the given concentration is the total concentration of this component.
'free' the given concentration is the free concentration of this species that

corresponds to this component and shall remain constant (eg. constant pH,
equilibrium with atmospheric CO,, free Me** constant, etc.).

Solid phases

'solidPhase' this component is a solid phase with activity=1.

'checkPrecip' to check if this component precipitates for a given concentration under the
chosen conditions, or define the amount of a solid phase that can be dissolved.

Adsorption

ConstantCap, Diffuse/GTL, SternL, and TripleL (Model of choice, see examples ).
'adsorbent1’, 'adsorbent2', ... 'adsorbent5' indicate different types of particles.
Several types of surface sites for one particle type (up to three are possible) are named:
'adsorbent1.1', 'adsorbent1.2' ..., the numbers meaning (which particle.which site).
The charges have to be named

'charge1.1' ... 'charge5.1' (for ConstantCap and Diffuse/GTL),

'charge1.1' 'chargei1.2' ... 'charge5.1' 'charge5.2' (for SternL), and

'charge1.1' 'chargel.2', 'charge1.3' ... 'charge5.1' 'charge5.2', 'charge5.3' (for
TripleL). The numbers mean (which particle.which charge)
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Creating a matrix by hand

Assume you want to calculate the pH and the distribution of the protonated and deprotonated species

of a 10® molar solution of acetic acid in pure water:

1St List all chemical species that occur in the system:

HAc, Ac, OH and H*

2nd | ook for a minimum amount of components with which you are able to formulate the chemical
formation of all your species (you need the chemical equilibrium formation constants, e.g. from
Martell and Smith, Critical Stability Constants, 1974-82). In our example this can be HAc and
H*. (Alternatively, the formation of the above species can be described with HAc and OH", with

Ac and H*, or Ac” and OH").

3rd  Write chemical equations for the formation of species using only components:

formation of HAc: HAc = HAc log K;=0
formation of Ac: HAc <= Ac +H* log K, =-4.73
formation of OH': H.,O <= OH +H* log K;=-14
formation of H*: H* <= H* log K,=0

4th \rite mass action expression for the species according to the above equations:

HAc =  K,-HAcl
Ac = K, HAcl - [H* 1
OH = Ky H!

H = K HY
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5th  The above equations define the system completely. To read these equations with a computer

eth

program, we put the stoichiometric coefficients, which are the exponents of the above
equations, into a matrix of the following setup: species form the lines, components the columns.

Formation constants are added to the line of the corresponding species:

HAc H* {log K}
Hac 1 0 0
Ac 1 -1 -4.73
OH 0 -1 -14
H* 0 1 0

The concentrations of the components are added at the end of the columns. We start out with
10° moles of HAc in one liter of pure water (no strong acid added, therefore the start total
concentration of H*=0). Calculation for a variety of concentrations is possible by just adding the

next concentrations in the subsequent lines (see example A).

Since the program needs to know the meaning of the concentration of the components (e.g.
are these total concentrations, or is one of them the concentration of the free species, or is one
of the components a solid phase or an adsorbing surface etc.) we have to define the mode of
each component. In our case the concentration of HAc is the fotal amount that is in the system
and such is H*. (In case you want to give the pH however, you have to give the concentration of

the free species H* (which is measured as pH).)

A collection of all predefined codes was given above. For our example they are 'total' for both

HAc and H*. They are added underneath the component names. Modes are fixed codes that
are recognized by the program. Names of species and components can be anything (or

nothing); it's just a text, except 'H+’ in the last column so the program knows it's the pH.

The program needs to know the charges of the species and components (only in case activity
coefficients and thus ionic strength is calculated). Write charges as '+' or '-' characters, e.g.

Pb++, POg---, etc.
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This is the final format for our matrix! Remarks or information about the stability constants can be added
to the right of the stability constants in {parenthesis}. Write on an EXCEL spreadsheet and save it in
text format. The extension ‘.cql’ is recognized by the program as a chemical matrix. (The following

matrix is in your set of examples in the ‘demo’ folder and is called 'aceticAcid.mat

HAc H* {log K}
total total
Hac 1 0 0
Ac 1 -1 -4.73 {25 deg, 1=0}
OH 0 -1 -14
H* 0 1 0
10° 0

Start the program, read the matrix by choosing Open Matrix... from the File menu, and start the

calculation with Go in the Run menu. You will obtain the following output:

‘006 Data
Species Stoich. M Log K Conc. [mal /1] Log conc.
Hac 10 0.00 8.725E-4 -3.06
Ac- 1-1 -4.73 1.275E-4 -3.89
OH- 0-1 -14.00 7.845E-11 -10.11
H+ 01 0.00 1.275E-4 -3.89
Components Mode Initial Conc. In or out of system

HAc total 1.000E-3 -——-

H+ total _—— e

Data can be saved with Save Data... (recommended extension: .xIs) and the matrix file with Save

Matrix... (recommended extension .cql) under the File menu.
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Regular species distribution in homogeneous
solution

The simplest case for a speciation calculation is a system where all components are dissolved, and total

concentrations are known: A solution of 10* moles/l of PbCl, in pure water.

Pb++, Cl- and H+ are selected for components. The combination of these three components
describes the formation of all species. (Of course one can choose other components as well, such as
PbOH+ and OH- if you wish for some reason). The components are selected from the library, with the

corresponding concentrations. The matrix looks as follows:

'6 ) & Matrix PbCl2.cql (fUsers/beat/Desktop/...

Pb++ Cl- H+
total total total
1.000E-4 2.000E-4 0.0
1.Pb++ 0.00
2. PbOH+ —7.70°25,0° Smith&Mar...
3. Pb(OH)2 -17.10725,0° Smith&Mar...
4. Pb(OH)3- -28.10 25,07 Smith&Mar...
5.Pb20H+++ -6.40 25,07 Smith&Mar...
6. Pb3(OH)4++ -23.90 "25,0° Smith&Mar...
7. Pb4(OH}M ++++ -20.90 "25,0° Smith&Mar...
8. Pb&{OH)B++++ -43.60 725,07 Smith&Mar...
9. PbCl+ 1.59 "25,0° Smith&Mar...
10. PbCI2 1.80 *25,0° Smith&Mar...
11. PbCI3- 1.70 725,07 Smith&Mar...
12. PbCl4-- 1.40°25,0° Smith&Mar...
13. Cl- 0.00
14. OH- -14.00
15. H+ 0.00@®

This matrix is in the demo folder and called 'PbCI2.mat'. The remarks to the right of the complex
formation constants give information on the conditions and origin of the constants: The first number
indicates the temperature and the second number the ionic strength at which the constants were
determined. Binding constants are from Smith&Martell: Smith and Martell, Critical Stability Constants

(1976).
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Go from the Run menu produces the following datasheet. You find that pH of the solution is 5.85, and

that chloro complexes are negligible:

8O Data
Species Stoich. Matri Log K Conc. [mal/l] Log conc.
Pb++ 100 0.00 9.784E-5 -4.01
PbOH+ 10-1 -7.70 1.392E-6 -5.86
Pb{OH)2 10-2 -17.10 3.951E-10 -9.40
Pb{OH)3 - 10-3 -28.10 2.817E-15 -14.55
Pb20H+++ 20-1 -6.40 2.717E-9 -8.57
Pb3(OH)4++ 30-4 -23.90 3.047E-13 -12.52
Pb4(OH)4++++ 4 0-4 -20.90 2.982E-14 -13.53
Pb6(OH)8 ++++ 6 0-8 -43.60 1.472E-21 -20.83
PbCl+ 110 1.59 7.584E-7 -6.12
PbCI2 120 1.80 2.451E-10 -9.61
PbCI3- 130 1.70 3.879E-14 -13.41
PbCl4-- 140 1.40 3.873E-18 -17.41
Cl- 010 0.00 1.992E-4 -3.70
OH- 00-1 -14.00 7.130E-9 -8.15
H+ 001 0.00 1.403E-6 -5.85
Components Mode Initial Conc. In or out of system

Pb++ total 1.000E-4

Cl- total 2.000E-4

H+ total —_—— —_——

You might want to calculate a speciation for a constant pH. In that case you must change the 'mode"' of

the 'H+' component from ‘total’ to 'free' since you want the free concentration of H* to be a certain

value. Click in the mode code in the matrix window will produce a pop up menu that lets you change

the mode:

& O & Matrix PbCI2.cgl (/Users/beat/Desktop/...

Pb++
total
1.000E-4

1.Pb++

2. PbOH+
3. Pb(OH)2
4. Pb{OH)3-

Cl-
total

2.000E-4

0.00

] H+
+ total

-7.707°25,0° Smith&Mar...

-17.10"25,0" Smith&Mar...
-28.10"25,0" Smith&Mar...

To change the concentration of H* just enter ‘1e-8’ in the number field in the interactive matrix window.

Go will calculate the speciation of the system with 10* moles of PbCl, in 1 liter of water at a pH of 8. Note

that you had to remove 7.74-10° moles of H* from that system in order to sustain a pH of 8:
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‘806 Data |
Species Stoich. Matri Log K Conc. [mal/l] Log conc.
Pb++ 100 0.00 2.902E-5 -4.54
PbOH+ 10-1 -7.70 5.790E-5 -4.24
Pb(OH)2 1 0-2 -17.10 2.305E-6 -5.64
Pb{OH)3- 10-3 -28.10 2.305E-9 -8.64
Pb20OH+++ 20-1 -6.40 3.352E-8 -7.47
Pb3(OH)4++ 30-4 -23.90 3.076E-6 -5.51
Pb4{OH)4+4+4++ 4 0-4 -20.90 8.926E-8 -7.05
Pb6(OH)8 ++++ 6 0-8 -43.60 1.500E-7 -6.82
PbCl+ 110 1.59 2.255E-7 -6.65
PbCI2 120 1.80 7.307E-11 -10.14
PbCI3- 130 1.70 1.160E-14 -13.94
PbCl4-- 140 1.40 1.161E-18 -17.94
Cl- 010 0.00 1.998E-4 -3.70
OH- 00-1 -14.00 1.000E-6 -6.00
H+ 001 0.00 1.000E-8 -8.00
Components Mode Initial Conc. In or out of system
Pb++ total 1.000E-4
Cl- total 2.000E-4
H+ free 1.000E-8 -7.740E-5

With Activity... binding constants are corrected for ionic strength either with Debye-Huckel,
Guntelberg, or Davies approximation. It is imperative that binding constants in the matrix are valid for 1=0
and that charges of all components and species are present as ‘+’ and ‘-‘ characters. There is the option
to define a ionic strength or let the program calculate the ionic strength that results from the
concentration input data of your matrix (for more information see section 'Activity'). For our system with
10 mol/l PbCl, the data sheet will give both concentrations and activities. Differences between

concentrations and activities in this system are very small:
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(8606 Data
Species Stoich. Matri Log K Conc. [mol{l] Activity Log conc.
Pb++ 100 0.00 9.794E-5 9.047E-5 -4.01
PbOH+ 10-1 -7.70 1.351E-6 1.325E-6 -5.87
Pb(OH)2 10-2 -17.10 3.871E-10 3.871E-10 -9.41
Pb(OH)3- 10-3 -28.10 2.89BE-15 2.8B41E-15 -14.54
Pb2OH+++ 20-1 -6.40 2.B59E-9 2.391E-9 -8.54
Pb3(OH)4++ 30-4 -23.90 2.92BE-13 2.705E-13 -12.53
Pb4(OH)4 ++++ 4 0-4 -20.90 3.361E-14 2.447E-14 -13.47
Pb&(OH)B++++ 6 0-8 -43.60 1.593E-21 1.159E-21 -20.80
PbCl+ 110 1.59 7.014E-7 6.B77E-7 -6.15
PbCI2 120 1.80 2.179E-10 2.179E-10 -9.66
PbCI3- 130 L.70 3.450E-14 3.38B2E-14 -13.46
PbCl4-- 140 1.40 3.585E-18 3.311E-18 -17.45
Cl- 010 0.00 1.993E-4 1.954E-4 -3.70
OH- 00-1 -14.00 7.487E-9 7.339E-9 -8.13
H+ 001 0.00 1.362E-6 1.362E-6 -5.87
Components Mode Initial Conc. In or out of system
Pb++ total 1.000E-4 ——=-
Cl- total 2.000E-4 —===
H+ total —— —
lonic strength: 2.973E-4 Approximation: DebyeHueckel

In order to display the pattern of Pb species in a pH range choose pH range... from the Option
menu and enter the range of interest in reasonable steps, e.g. from 5 to 14 in steps of 0.25 pH units.
Represent the curves graphically for better overview by choosing Graphics... from the Options

menu and select the species of interest. This will produce the following output:

‘®e® Graphics
0B} e e ., Le st T T e PE

°
2
3
I

9085 : . . PO(OH)E-

o

PD3(OH}++

8.0E-5-]

7.0E-5

6.0E-5-]

3.0E-5 . a
2.0E-54 . o

1.0E-5-]

0.0€0 gg? 2t i s 0 0 go9g X
5.00 6.00 7.00 8.00 9.00 10.00 11.00 1200 13.00 14.00
pH range

A datasheet that can be saved is printed in the back of the plot.
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Octanol-water and gas-water distribution

Equilibrium calculations that contain octanol-water distribution, gas-water (Henry)
coefficients or dissolution of organic substances can easily be included in speciation calculations.
Use the octanol-water or Henry coefficients in the same way as regular formation constants are used to

characterize the species.



ChemEQL Manual 39

Solid phases: dissolution and precipitation

Put up a matrix to calculate solubility

We use the dissolution of Al(OH)4Gibbsite) as an example to demonstrate the calculation when one (or

more) component(s) is a solid phase:

Al-species must be described using the solubility product of the solid phase, Al(OH) ,(Gibbsite). Collect

‘Al+++’ and ‘H+’ from the Regular Library (Access Library...):

r

806 MNew Matrix
Al+++ H+

total total

1.0 0.0
1L Al+++ 0.00
2. AIOH++ -5.00 "25,0° Stumm&Mo...
3. Al(OH)2+ -10.10 725,07 Stumm&Mo...
4. Al(OH)3(ag) -16.90 "25,07 Stumm&Mo...
5. Al{OH)4- -22.70725,0° Stumm&Mo...
6. AlI2(OH)2++++ —7.70725,07 Smith&Mar...
7 AIBOHM++4+++ -13.90 25,07 Smith&Mar...
8. OH- -14.00
9.H+ 0.00@

Then insert ‘Al(OH)3(Gibbsite)’ to replace ‘Al+++’ (Insert Solid Phase...).

r = = -

enn Insert Solid Phase
logKso
-8.11

Replace  Al+++ T‘

with  "Al(OH)3 (Cibbsite, crist)" e

StummNorgan 98

Al+++ =<==> 3H4+ + "AIOH)3 (Cibbsite, crist)"

[ Cancel ) ( Ok )
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The equation for which the solubility product is valid is shown in the gray text field. Replacement can
be performed only if the matrix contains all components that occur in this equation (an error message
will occur if this is not the case). The active text field allows you to enter your own solubility constant if
you do not want to use the one given by the library. If the setting is correct the program will introduce
the solid phase in the matrix, recalculate all stoichiometric coefficients and binding constants, set the

mode to 'solidPhase' and the activity = 1:

‘@06 New Matrix
"Al{OH)3 (Gibbsite, ... H+
solidPhase total
1.0 0.0
1 Al+++ 8.11
2. AIOH++ 3.11 "25,0° Stummé&Ma...
3. AlIOH)2+ -1.99 "25,0° Stummé&Mo...
4. Al(OH)3(ag) -B8.79 725,07 Stumm&Mo...
5. Al(OH)4- -14.59 725,07 Stumm&Mo...
6. AlI2(OH)2++++ 8.52 "25,07 Smith&Mar...
7. AIBOHM +++++ 10.43 "25,0° Smith&Mar...
8. OH- -14.00
9. H+ 0.00@

(This matrix is stored in the ‘demo’ folder as 'Al(OH)3.cql")

Dissolution

The above matrix characterizes the dissolution of a chunk of Gibbsite in pure water (without CO,).
Calculation will result in the composition of the solution in thermodynamic equilibrium and the amount

of Gibbsite dissolved (2.58'10 mol/l):
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‘806 Data i

Species Stoich. M Log K Conc. [maol/l] Log conc.
Al+++ 13 8.11 1.787E-13 -12.75
AlOH++ 12 3.11 1.603E-11 -10.80
Al(OH)2 + 11 -1.99 1.141E-9 -8.94
Al(OH)3(aq) 10 -8.79 1.622E-9 -8.79
Al(OH)4- 1-1 -14.59 2.305E-8 -7.64
AlZ(OH)2++++ 2 4 8.52 5.124E-20 -19.29
AlJ(OH)4 +4++++ 35 10.43 4.645E-25 -24.33
OH- 0-1 -14.00 8.966E-8 -7.05
H+ 01 0.00 1.115E-7 -6.95
Components Mode Initial Conc. In or out of system

"AlI(OH)3 (Gibbsite, c... solidPhase unlimited 2.583E-8

H+ total ———> e

Dissolution in acidic solution
Of course you can dissolve a lot more Gibbsite when the solution is acidified. Lets add, say 10® moles
of strong acid: change the concentration of ‘H+’ in the interactive matrix window, but leave the mode

‘total’. Then start the calculation. We end up with a solution of pH about 3.9 and 2.985-10* moles

Al(OH),(Gibbsite) dissolved:

806 Data

Species Stoich. M Log K Conc. [mol/l] Log conc.
Al+++ 13 8.11 2.756E-4 -3.56
AlOH++ 12 3.11 2.139E-5 -4.67
Al(OH)2 + 11 -1.99 1.318E-6 -5.88
Al(OH)3(aq) 10 -8.79 1.622E-9 -8.79
Al(OH)4- 1-1 -14.59 1.995E-11 -10.70
AlZ(OH)2++++4 2 4 8.52 9.126E-8 -7.04
AlJ(OH)4 +++++ 35 10.43 9.558E-10 -9.02
OH- 0-1 -14.00 7.761E-11 -10.11
H+ 01 0.00 1.288E-4 -3.89
Components Mode Initial Canc. In or out of system

"Al{OH)3 (Gibbsite, c.. solidPhase unlimited 2.985E-4

H+ total ———> e

Dissolution at constant pH

Changing the mode from ‘total’ to ‘free’ indicates a system where pH is held constant at pH = 3. The
result sheet shows that 0.13 mol Gibbsite was dissolved in one liter, and that 0.39 mol H* was needed

per liter to keep the pH constant at 3.0:
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Components Mode Initial Canc. In or out of system
"Al{OH)3 (Gibbsite, c... solidPhase unlimited 1.309E-1
H+ free 1.000E-3 3.915E-1

Graphical representation of solubility over a pH range

Calculate the solubility of Gibbsite in the natural pH range of water and display the result logarithmically
versus pH (log-log plot): Change the mode of ‘H+’ from ‘total’ to ’free’ with the pop up menu in the
matrix window. Then choose a pH range... (Options menu) from 3 to 8 in steps of 0.2. Select
Graphics... (Options menu) and mark the first 5 Al-species. Finally, change the Format (Options

menu) from ‘Linear’to ‘Logarithmic’. Go in the Run menu will produce the following plot:

1,037 < Al
1.0E-4 x AIOH)2+

+ AI[OH)3(aq)
1.0E-5F AIOHM-
10E6+

1.0E-74 e
1.0E-84
1.0E-04
1.0E-104

1.0E-11

[inau uoneuaauod

1.0E-12

1.0E-13

1.0E-14

1.0E-15

1.0E-16

1.0E-17

1.0E-18

1.0E-19 |

pH range

Precipitation

The code ‘checkPrecip’ allows to test if a solution of given composition is oversaturated or
undersaturated with respect to a solid phase. For an example, we start with a solution of 10 moles of
Gibbsite in a solution of pH 2 and want to know when Gibbsite precipitates (if at all) if we rise the pH

continuously, e.g. during a titration.
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This task can be accomplished with the same matrix. Change the mode code of 'Al(OH),(Gibbsite)' from

'solidPhase' to 'checkPrecip'. The component now stands for total Al in the system and requires a

concentration. Enter ‘1e-6’. Adjust the concentration of ‘H+’ to ‘1e-2’ and make sure the mode is

‘free’, indicating constant pH. The matrix now looks like this:

'y

&)

Matrix AI{OH)3.cql (/Users /beat/Deskto

"Al(OH)3 (Gibbsite, ...

checkPrecip
1.000E-6

H+
free
1.000E-2

-=> pH is constant: 2.000

WD~ w2

CAl+++
AIOH++
LAIOH)2+

. Al(OH)3(ag)
LAl(OH)4-
CAIRZIOH)24++4++
CAIOHM ++4+++

OH-
H+

8.11

3.11°
-1.99°
-8.79°
-14.59°
8.52"
10.43"

-14.00

25,07 Stummé&Mo...
25,07 Stumm&Mo...
25,07 Stumm&Mo...
25,07 Stummé&Mo...
25,07 Smith&Mar...
25,07 Smith&Mar...

0.00727?

To check for the pH region where precipitation possibly occurs choose a pH region, eg from 2 to 10 in

steps of 0.5 (pH range... in the Option menu), then Go. You will get the following datasheet:

806 Data

tot. "Al{OH)3  diss. "Al{OH}3  precip. "AlIOH)3 Al+++ AlOH++ AllOH)Z+ AllOH)3(aqg]
1.000E-6 1.000E-6 9.990E-7 9.990E-10 7.935E-13 1.258E-17 1
1.000E-6 1.000E-6 9.968E-7 3.152E-9 7.918E-12 3.968E-16 1
1.000E-6 1.000E-6 9.900E-7 9.900E-9 7.864E-11 1.246E-14 1
1.000E-6 1.000E-6 9.086E-7 3.003E-8 7.694E-10 3.856E-13 1
1.000E-6 1.000E-6 9.026E-7 9.026E-8 7.169E-9 1.136E-11 1
1.000E-6 1.000E-6 7.163E-7 2.265E-7 5.090E-8 2.852E-10 1
1.000E-6 3.619E-7 6.381E-7 1.288E-7 1.288E-7 1.023E-7 1.622E-9 2
1.000E-6 5.175E-8 9.482E-7 4.074E-9 1.288E-8 3.236E-8 1.622E-9 8
1.000E-6 1.584E-8 9.842E-7 1.288E-10 1.288E-9 1.023E-8 1.622E-9
1.000E-6 1.312E-8 9.869E-7 4.074E-12 1.288E-10 3.236E-9 1.622E-9
1.000E-6 2.836E-8 9.716E-7 1.288E-13 1.288E-11 1.023E-9 1.622E-9
1.000E-6 8.323E-8 9.168E-7 4.074E-15 1.288E-12 3.236E-10 1.622E-9
1.000E-6 2.588E-7 7.412E-7 1.2BBE-16 1.288E-13 1.023E-10 1.622E-9
1.000E-6 8.145E-7 1.B55E-7 4.074E-18 1.2B8E-14 3.236E-11 1.622E-9
1.000E-6 1.000E-6 5.009E-20 5.009E-16 3.979E-12 6.306E-10
1.000E-6 1.000E-6 5.011E-22 1.585E-17 3.980E-13 1.995E-10
1.000E-6 1.000E-6 5.012E-24 5.012E-19 3.981E-14 6.309E-11
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The first column of the datasheet gives the total concentration (the sum of dissolved and precipitated

Al), the second column the total amount of actual dissolved Al. The third column lists the amount of

Gibbsite precipitated from the solution — which is the difference between total and dissolved Al. All

following columns express species concentrations as usual. Each line is the result of the calculation for

a given pH. Graphically displayed:

806

10EET " "ew,,

9.0E-74
B.0E-74

o, T.0E-7-

iy
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- 5.0E-T+
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3.0E-74
2.0E-74

1.0E-7-
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pHrange
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Al+++
AlOH++
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+ Al(OH)3(aq)

Al{OH)4-
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Adsorption to particulate surfaces

Introduction to the principles of surface adsorption

This chapter gives a short introduction of the ideas of adsorption models, the information needed to
implement the various electrostatic models in ChemEQL, and how to include the specific surface
parameters in the matrix. For detailed discussion of the models as well as good reviews see Dzombak

and Morel (1990), J. Westall and H. Hohl (1980), or Stumm and Morgan (1996).

The free energy of adsorption actually consists of a chemical term describing the chemical
interactions, and an electrostatic term accounting for electrostatic attraction and repulsion that

occur at interfaces:
AG = AGchemical + AG(—.\Iectrostatic

The electrostatic term can be looked at as a type of activity coefficient that has to be taken into account
for adsorption reactions of charged species. The coulombic term expresses the work needed to

transport n charges through a potential gradient ¥:
AGelectrostatic = nFlP

where F the Faraday constant (electrical charge of 1 mole of electrons) and W the surface potential in

Volts. Since AGy.mca = -RT In K we can write adsorption reaction constants as
K = K- exp(-nF¥/RT)

R is the molar gas constant and T the absolute temperature. The exponential term is compatible with
the chemical potential term and can therefore be included in the set of components. The formation of
adsorbed species can now be described by introducing their charge in the column with the
exponential term in addition to the chemical interaction. The concentration that is to put for this column

is the total sum of all surface charges:

Pt = ({(=SOH,'} + {=SOPb*} + ...) - ({=SO} +...)
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or expressed as a charge: o =Py - F/ISA

where S is the specific surface area, and A the concentration of solid.

Different relationships between charge and surface potential can be thought of and therefore various
models were created accordingly, the most simple one being the constant capacitance model where

charge and potential are related only through the capacitance C (see literature cited above):

o=C-¥

The recent literature recommends to use the model of the Diffuse Double Layer (Dzombak and Morel,

1990; Stumm, 1997) where

. ([ ZYF
5= (8RTee,c-10°) 2 sinh
2RT
¢ and g, are the dielectric constant of water and the permittivity of free space, respectively. c is the

molar electrolyte concentration, and Z the ionic charge.

How to put up an adsorption matrix: A simple example:

Pb adsorbs to Fe-oxide particles under near neutral and alkaline conditions. We need additional
information on the nature and chemical behavior of the suspended patrticles such as: Specific surface
area, concentration of surface sites, ionic strength and capacitance of the electric double layer. Choose
the model you wish to use to account for the electrostatic interactions between charges: You have the
choice of either the Constant Capacitance Model ('ConstantCap'), the Diffuse Double Layer Model or
the Generalized Two Layer Model ('Diffuse/GTL'), the Basic Stern Layer Model ('SternL') or the
Triple Layer Model ('TripleL'). With ChemEQL you have the possibility of choosing either (up
to five) different types of adsorbents or (up to three) different types of surface sites

on one type of adsorbent.
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Adsorbing surface sites and surface charges are introduced in the matrix as components. We assume
here one type of particle with one type of surface site, and the formation of two types of surface
complexes which differ only in stoichiometry, modeled as mono- and bidentate surface complexes of
Pb. Adsorption matrices cannot be put up from the library but must be organized in EXCEL. In the

adsorption matrix surface site(s) are treated like ordinary ligands:

FeOOH -> [FeOOH] = 10 [FeOOH]

FeOOH < FeOO" + H* EFF%)%J]H = 1079 -> [Fe0O] = 10[FeOOH]H']!
[FeOOHg*]

FeOOH * H* < FeOOH,* [Fe0OMH = 1087 -> [FeOOH'] = 10°7-[FeOOH][H']

Pb? -> [Pb*] = 10 [Pb*?]

FeOOPb*][H*
FeOOH + Pb? < FeOOPb* + Hr  omdrb ] 45052

FeOOHIPo™2] = -> [FeOOPb*] = 105 [FeOOH][Pb*?][H"}’

[(FeOO)oPOIIH* £627

2FeOOH + Pb*? < (F: Pb+2H" ———s——— =
eOOH + < (FeOO0),Pb + [FeO OH]2[Pb +2]

-> [(FeOO0),Pb] = 10°%27-[FeOOHF[Pb*?][H* ]2

Add the additional information required at the bottom of the matrix as shown in the following example.
Make sure to use correct codes for double layer models and correct modes for components: The
column containing the particulate ligand must be called 'adsorbent1' (you can have up to five
different particles; see further examples. Call them 'adsorbent2', 'adsorbent3' etc.). If you wish to
use different types of surface sites (up to three are possible) call these components 'adsorbenti.1’,
'adsorbent1.2' etc. The numbers indicate 'adsorbent(whichParticle.whichSite)'. Columns containing
charges must be called 'charge1.1', 'charge2.1', etc for Constant Capacitance and Diffuse Double
Layer models. The Triple Layer model requires three charge components: 'charge1.1’,

'chargei1.2', 'charge1.3' for each adsorbing type of particles, the numbers indicating

'charge(whichParticle.whichCharge)'. See examples 11-16 later.
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0 is entered for the concentration of adsorbent (since the program will calculate concentrations from
the input of other parameters and does not require this input), and 0 for the sum of charges (for

Constant Capacitance and Diffuse Layer models where there is only one double layer).

FeODOH exp{-FY/RT) Ph++ H+ {log K}
adsorbent 1 chargel .1 total free
FeOOH 1 0 0 0 a
FeOO- 1 -1 0 -1 -9
FeOOHZ + 1 1 0 1 6.7
FeOOPb+ 1 1 1 -1 -0.52
{Fe0D}Z2Pb 2 0 1 -2 -6.27
Pb++ 0 0 1 0 0
PbhOH+ 0 0 1 -1 -7.7
Pb{OH}2Z o 0 1 -2 -17.1
Pb{OH}3- 0 0 1 -3 -258.1
OH- 0 0 0 -1 -14
H+ 0 0 0 1 a
0 0 1.00E-06A 1.00E-07

ConstantCap  { model: ConstantCap, Diffuse/GTL, Sternl or TriplelL}
14.7 {specific surface area in [m2/7g]}
1.25E-04 {no_ of active surface sites in [mol fq]}
0.1 {conc. of adsorbent in [g/1]}
0.01 {ionic strength in [mol 71]}
2.9 {capacitance of inner layer in [F/m2]}

The above matrix is located in the demo folder and is named 'FeAdsorption.cql', and calculation
can be performed directly. The lower part of the data window contains the total concentration of
adsorption sites as calculated from the input of specific surface area, number of active surface sites,
and concentration of adsorbent. The total concentration of surface charges sums up all charges of

surface species and expresses them in moles per liter.

Components Mode Initial Conc. In or out of system
FeOOH adsorbentl 1.350E-5 e
exp(-FY/RT) chargel.l 1.659E-6 ———
Pb++ total 1.000E-6 e
H+ free 1.000E-7 -9.162E-8

Titration of a solution with particles

If you use matrices with adsorption to particulate surfaces you have the additional option to titrate your

system with particles, ie. to vary the particle concentration in a specified range, much similar
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to the option of varying the concentration of a component. Choose Adsorption range... from the

Options menu, and enter the range of concentrations of your particulate matter.

r = = -

e \ Adsorption range

In case of several adsorbents, only the amount of the
first adsorbent can be varied. Total solid concentration
in [g/1] will be printed in the first column of the output.

Give the range of the particulate concentration in [g/]] :

from: 0.001  to: 0.05  step:|0.001

[ Cancel ) ( Ok }

The Generalized Two Layer Model

Dzombak and Morel in their first compilation of experimental adsorption data recommend for pragmatic
reasons the use of the Generalized Two Layer Model. The Generalized Two Layer Model
basically consists of the Diffuse Double Layer Model combined with the Surface
Precipitation Model by Farley et al (1985), which can account for the eventual formation of a solid
solution phase on the surface at high sorbate to sorbent ratios. The diffuse layer model considers one
layer of surface charges and a diffuse layer of counter charges in solution. A capacitance is not
needed. The authors recommend using one surface site to model anion adsorption data, and two site
types ('strong' and 'weak' surface sites, both site types are considered to have the same
proton binding characteristics!) to model cation adsorption data. They find this basic two-layer
model adequate for the description of all but the highest cation concentrations. An example for the
cation surface complexation with two site types on one sort of particles as recommended by Dzombak
and Morel, however without surface precipitation, is given below. (Example 4.2). It is named 'GTL.mat'

in your demo folder.
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strong FeDOH weak FeOOH exp{-FY/RT) Pb++ H+ {log K}

adsorbent1.1 adsorbent1.2 chargel_1 total free
strongFeD0OH 1 o 0 o o o
strongFeD0- 1 o -1 o -1 -9
strongFeD0OH2 + 1 o 1 o 1 6.7
weakFe00OH 0 1 0 1] 1] 1]
weakFedD- 0 1 -1 1] -1 -9
weakFeDOH2Z + 0 1 1 1] 1 6.7
strongFeD0OP b+ 1 a 1 1 -1 -58.52
weakFeDOP b+ 0 1 1 1 -1 -6.27
Pb++ 0 1] 0 1 1] a
PbhOH+ 0 1] 0 1 -1 =77
Pb{OH}2Z 0 1] 0 1 -2 -17.1
Pbh{OH}3- 0 1] 0 1 -3 -28.1
DH- 0 1] 0 1] -1 -14
H+ 0 1] 0 1] 1 1]

0 1] 0 1.00E-06  1.00E-07F
Diffuse GTL {model: ConstantCap, Diffuse/GTL, SternL or TriplelL}
14.7 14.7 {specific surface area in [m2/gq]}
1.35E-04 2.00E-04 {no_ of active surface sites in [mol/q]}
0.1 0.1 {conc. of adsorbent in [g/11}
0.01 0.01 {ionic strength in [mol 711}

Note that no capacitance is needed in the input matrix. At high sorbate/sorbent ratios precipitation of
the hydroxide or carbonate of the adsorbing cation on the surface was observed by Farley et al.
(1985). Their model considers the formation of a new surface phase. To describe the formation of a
'solid solution' on the surface solubility products determined for bulk solutions are applied. All surface
reactions need to be described as surface precipitation reactions. A new component is introduced in
order to describe the fractions of sorbate and sorbent in the solid solution. An example for the sorption
and precipitation reactions of a cation M* on a hydrous oxide X(OH),(s) is taken from Dzombak and

Morel (1990), p. 29-32:

Adsorption of M?* on X(OH)gs):

= XOH" + M** + 2H,0 <> X(OH),(s)+ = MOH; + H" K P
Precipitation of M?:

= MOH; + M** +2H,0 <> M(OH),(s)+ = MOH +2H" Keon”
Precipitation of X**:

= XOH’ + X** + 3H,0 <> X(OH),(s)+ = XOH" + 3H" Ko
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The adsorption reaction of X** on M(OH),(s) can be derived from the above equations and is not
shown. The component Ts represents the total mass of solid material in solid solution and is used to

express the activity constraint on the solid solution.

The matrix that results from this input and suits the need of the complete 'Generalized Two Layer
Model' for cation adsorption including surface precipitation looks like represented in the following table
('GTL-Precip.table' in the demo folder) and only needs to be completed with the appropriate formation

constants and concentrations:

strongXOH weakX0OH  exp{-FY/RT) HM++ X+ ++ Ts H+ {log K}
adsorbent1.1 adsorbent1.2 chargel_1 total total total free
strongX0H 1 u] u] o o u] u] o
strongX0- 1 0 -1 o o 0 -1
strongX0H2 + 1 u] 1 o o u] 1
weakX0H 1] 1 u] 1] 1] u] u] 1]
weakX0- 1] 1 -1 1] 1] 0 -1
weakX0OHZ + 1] 1 1 1] 1] 0 1
strong=MOH2 + 1 0 1 1 -1 0 2
weak=HMOHZ+ 1] 1 1 1 -1 0 2
X+++ 1] 0 0 1] 1 0 0 1]
M{OH}2(s) 1] 0 0 1 1] 1 -2
X{0H)3(s) a 0 0 1] 1 1 -3
{M{OH}2{s)} 1] 0 0 1 1] 0.1 -2
{X{0H)3(3)} 1] 0 0 1] 1 0.1 -3
M++ 1] 0 0 1 1] 0 0 1]
HMOH+ 1] 0 0 1 1] 0 -1
M{OH)}Z{aq) 1] 0 0 1 1] 0 -2
H{OH}3- 1] 0 0 1 1] 0 -3
DH- 1] 0 0 1] 1] 0 -1 -14
H+ 1] 0 0 1] 1] 0 1 1]
1] 1] 1] totHM  otX-Xpar 1 totH
Diffuze/GTL {model: ConstantCap, Diffuse/GTL, SternL or TrippleL}
14.7 14.7 {specific surface area in [m27gq] -> same for "strong” and "weak"}
1.35E-04 Z.00E-04 {no. of active surface sites in [mol 7g] -> different for “strong” and "weak'}
0.1 0.1 {conc._ of adsorbent in [g/1] -> same for “strong” and "weak'}
0.01 0.01 {ionic strength in [molf1] - > same for "strong” and “weak'}

Surfaces characterized by Fractional Surface Charge:
The one-pK-model

The one-pK-model (Westall, 1987) simplifies the description of the acid-base equilibria by assuming
only one proton exchange reaction. (The following example and more are published and discussed in

the 2nd ed. of Stumm, 1992):
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SOH."> <> SOH™"* + H" K,

In fact, a new uncharged component, SOH?, 5, was introduced to allow the equilibria to be described

with only one protolysis constant:

41 Ly 0 L _y
SOH,’? «<—2——>SOH,,«<———>SOH ?

The matrix therefore needs the uncharged surface species as a component, and the two species with

broken charges:

S50H1.5 exp{-FY/RT) H+
adsorbent 1 charge1.1 free
50HZ+0.5 1 0.5 0.5 3.25
S50H-0.5 1 -0.5 -0.5 -3.25
DH- 0 1] -1 -13.5
H+ 0 1] 1 1]
0.00E+00 0 1.00E-07

Diffuse/GTL  { model}
129 {surface area}
1.28E-04 {conc of surface sites}
G174 {conc in g/fl1}
0.1 {ionic strenght}

The program calculates the total concentration of surface sites from the entries of the concentration of
adsorbent [kg "] and the characteristic conc. of surface sites [mol kg™]. In the column of the surface

charges of the species are the differences in surface charge for the reaction considered. The potential
difference across the double layer is calculated according to the model chosen, preferably the Diffuse

Double Layer model.

Anion or cation sorption is introduced with the following type of equations:
_1 1 .
cation: SOH % + Me** <> SOMe % +H

anion: SOH ™ + HA <> SA™* + H,0



ChemEQL Manual

53

Examples

The next three examples show basic input matrices for the four different models. Further examples in

the 'examples' chapter will demonstrate the use of several types of adsorbents.

Example for a basic matrix of surface speciation according to the Constant Capacitance Model

(‘ConstantCap.mat' in demo folder):

Example for a basic matrix of surface speciation according to the Diffuse Layer Model, which is

S0H exp{-FY/RT)
adszorbent1 chargel._1

1.00E-07

50- 1 -1
S0H 1 o
SOHZ+ 1 1
OH- 1] 1]
H+ ] ]
0.00E+00 o
ConstantCap
129 {surface area}
1.37E-04 {conc. of active surface sites}
8174 {conc. of adsorbent}
0.1 {ionic strenght}
1.06 {capacitance}

recommended to use by Dzombak and Morel ('Diffuse/GTL.mat'):

SOH exp{-FY/RT)
adsorbent1 chargel.l
-1

1]
1
1]
1]
1]

S50- 1

SOH 1

SOHZ+ 1

OH- ]

H+ ]
0.00E+00

Diffuse/GTL {model}

129 {surface area}

1.28E-04 {conc of surface sites}

8.174 {conc in gf1}

0.1 {ionic strenght}

H+
free

-1

1]

1
-1

1

1.00E-07

Surface speciation according to the Basic Stern Layer Model:

-5.93

.66
-13.8
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S50H 1.charge Z.charge H+
adsorbent1l chargel.l chargel .2 free
s0- 1 -1 0 -1 -g.46
SOH 1 ] ] ] 0
SOHZ+ 1 1 0 1 g.16
OH- 0 ] ] -1 -13.8
H+ ] 1] 0 1 0
0.00E+00 0.00E+00 0.00E+00 1.00E-07
SternlL { model}
129 {spec. surface m2/q}
1.33E-04 {sites conc. in molesq}
8174 {conc_in g1}
0.1 {ionicstrength}
2.4 {inner capacitance Ffm2}

Surface speciation according to the Triple Layer Model:

S50H 1 _charge Z.charge J.charge H+
adsorbent1 chargel.1 chargel.? chargel.3 free
S50-HNa+ 1 -1 1 ] -1
SO0HZ+C104- i 1 -1 0 1
50- 1 -1 0 0 -1
S0H 1 ] ] ] ]
S0HZ+ 1 1 ] 0 1
OH- ] ] ] ] -1
H+ ] ] ] 0 1
0.00E+00 0.00E+00 0.00E+00 0.00E+00 1.00E-07
Triplel { mode1}
129 {spec. surface m2/q}
1.2ZE-04 {sites conc. in molefg}
3174 {conc. in gf1}
0.1 {ionicstrength}
1.2 {inner capacitance F/m2}
0.2 {outer capacitance}

Literature:

-9.31
7.33
-9.31

733
-13.8

Dzombak D.A., and F.M.M. Morel: Surface Complexation Modelling. Wiley Interscience (1990).

Farley K.J., D.A. Dzombak, F.M.M. Morel: A surface prepcipitation model for the sorption of

cations on metal oxides. J. Colloid Interface Sci. 106, 226-242 (1985).
Stumm W., and J.J. Morgan: Aquatic Chemistry, 3rd ed. (1996).

Stumm W.: Chemistry of the solid-water interface. Wiley Interscience, 1992.
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Westall J., and H. Hohl: A comparison of electrostatic models for the oxide-solution
interface. Adv. Coll. Interface Sci., 12, 265-294 (1980).

Westall J.: Adsorption mechanisms in aquatic surface chemistry. in: Aquatic surface
chemistry, ed. by W. Stumm, John Wiley and Sons, New York, 3-32 (1987).
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Redox Reactions

The (microbially mediated) redox equilibrium between N(V) and N(-1ll) is calculated as an example. The
electron, which is part of these reactions, must be a component. The following equations are in the

library and can be accessed easily:

NO, -> [NO,] = 10% [NO,]

NO,” + 9H* + 8¢ NH, + 3H,0 Ml _ 101099 NH,] = 107%%[NO;, Jle' F[H'F
s + + o6 < 3 + SMp [NO3'][H+]9[e']8 = -> [NH;] = [NOs Jle’Fl
NO - H+ - NH + 3H O & —_ 101192 NH +] — 10119.2. NO - - H+ 0

; + 10H* + 8" <« NH,* + 3H, NOZ THTOR B ~ -> [NH = INO; Jle” PIH'T
2H,0 < Oy + 4H* + de [O2(g)le THH*TY = 1083 > [Opgl = 10%JH T
[Ho(g)]

2H' + 26 < Hy, [e']2[l(-?'3']2 = 100 > [Hyl = 10°[e F[H'F

e > [e] = 10° [e]

H* -> [H] = 10% [HY]

A | B | C | D | E |

1 hOE- e- H+
2 total free free
3 [MO3- 1 1] 1] 0
4 [MH3 1 3 q 109.9
5 [MHd+ 1 g 10 119.2
6 [02(q) 0 - -4 -83
7 |Hz(q) 0 2 2 0
8 [e- 0 1 1] 0
9 [0H- 0 1] -1 -14
10 (H+ 0 1] 1 0
11 S.00E-04 3.00E-06 3.00E-03
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This matrix is stored in the demo folder under the name 'Redox.mat'

To represent the development of the N(V)-N(-1ll) couple in a pe-range choose Component range...

from the Options menu. Select the e- component and enter a logarithmic interval from -8 to -2 in
steps of 0.25. (The output format is now set to logarithmic as you can check in the Format item).

Select Graphics... and mark the first five items to obtain the curves. Go will calculate the following

graph:

.l

l®

o (D)

[Irow] uopeguaauod

S S S S S S

oW

Graphics
- 590000000000000000
<o .
% o .
[+]
o .
x 0
<o .
[+] - -
.
o . .
- .t
[+] - .
- . -
. s
59 "
.
-
.
10E8 1.0E7 1.0E6 1.0E5 1.0E4 1.0E3 10E2 1.0E

conc. range of free e-

NO3-
NH3

NHd+
C2(a)
H2(g)

NO; prevails in the region where log e is smaller than -5.5, and NH,* under more reducing conditions

where log e >-5.5.
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Kinetics

ChemEQL allows the calculation of species distribution in a system that is controlled by one rate
limiting chemical reaction. The chemical speciation is assumed to be much faster than the selected
kinetic reaction. The program covers the most common types of kinetic rate equations. (No

consecutive kinetic reactions are possible, however.)

In a first step the program performs a speciation calculation that results in the concentrations of the
species before any kinetic reaction takes effect (, = 0). The equilibrium concentration of the educt
species (E) is then set to the start concentration of the educt for the kinetic calculation. The following
kinetic calculation therefore uses the concentration of the educt species (and not the total
concentration of the educt component). The amount of E used up in this process is subtracted from
the total concentration of E, and the product (P) produced by this step is added to the total
concentration of P. A speciation calculation is then performed and the result given in the output. If the
kinetic reaction is reversible (includes a backreaction) or autocatalytic (product enhances speed of
reaction), the concentration of P that takes part in the kinetic calculation is of course also the free

concentration of the product species and not the total concentration of P.

The input matrix must be organized such that educt and product are components:

Educt Product H+ {log K}
total total
Educt 1 0 0 0 0
Product 0 1 0 0 0
ProdSpecies1
ProdSpecies2
OH- 0 0 0 -1 -14
H+ 0 0 0 1 0
startConc usually=0
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Be aware of the dimensions of the kinetic constants! Use moles I sec” (zero order), sec” (1St

order), | moles™ sec™ (2N d order) etc. or remember that the time scale of your input will change

the output accordingly.

The following dialog appears if you choose Kinetics... from the menu:

- Yale Kinetics [

zero order:

@ cC->pP+... -dCl/dt=k
first order:

D cC->pP+...  -dICl/dt =k[C]

JC<e->584+.. -d[C]/dt = k(f)[C] - k(b)[S] (reversible)
second order:

_eC->pP+..  -dICl/dt = kIC][C]

- C+D -> P+ ... -d[C]/dt = k[C][D]

JC->P+... -d[C]/dt = k[C][P] (autocatalysis)
third order:

eC->pP+... -d[C] = kICIICIIC)

educt C: ‘eductC | 4] coeffe: |

product: product P ﬂ coeff. p: [

rate constant k =

time interval dt = time end =

[ Cancel )

Choose the desired rate law, define educt and product of your system, enter the stoichiometric
coefficients, rate constants, and time interval. For graphical display of one or more species choose

Graphics... from the Options menu after closing the kinetic dialog.

A few basic examples for simple Kinetic calculations without speciation are given below. The following

general matrix can be used to demonstrate the function of all types of kinetics:
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Educt C Product P anyComp. H+
tofaF tofaf tofaf free
Educt C 1 0 0 0 i
Product P 0 1 0 0 0
any Species 0 0 1 0 0
more Species u] u] 1 -2 -1z
OH- 0 0 0 -1 -14
H+ 0 0 0 1 a
7.2E-2 Z.0E-4 1.0E-6& 1.0E-5
+ EductC o ProductP
Zero order:
(k=1073, t=5-100)
et KINETIC: time in sec 1oeE
BQE—Z
First order:
(k=0.01, t=10-300)
0.0e+0 I.0e+2
KINETIC: time in sec
+ EductC o ProductP

Bhe-2

Reversible:

EqUiTibrium conc. of comp Edusts

without speciation would be: 3.6e-2

(k=0.05, kback=0.05, t=2-50)

0.0e+0 S.0e+1
KINETIC: time in sec
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* EductC

Second order in C:

(k=1, t=2-50, logarithmic scale)

KINETIC: time in sec

Second order overall, but first order in C

and D: (k=1, t=2-50, logarithmic scale)

* EductC = ProductP
8.6e-2

Autocatalysis: (k=14.6, t=0.5-10,
Example see Frost&Pearson, Kinetics and

Mechanism, Wiley 1961, p19)

KINETIC: time in sec

+ EductC

Third order:

(k=100, t=1-20, logarithmic scale)

KINETIC: time in se
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Integrated rate laws

zero order: cC - P [C]t =C, —ckt
first order: cC - P [C],=C, exp™
k+ k' exp“)r

C < P (reversible) [C]t=C0

(k + k') - exp®

__ G
C,ckt +1

Second order: cC —- P [C]r

C P p'expkt(CO+P0)—C
cC — pP (autocatalysis) [C]t=l C, - OCO( > e ))
c cCy+ pP,-exp """

1
[P] =;{C0+P0—c[C]t}
Third order: cC - P [C] =L
" \2ckiCE +1
n" order: cC - P [C]t - G

((n=1)ckeCy™ + 1)%
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pX-pY diagrams

The pX-pY diagrams option is of use in the calculation of the prevailing dissolved species or solid
phases of a component under varying conditions of another parameter like the redox potential
(pe), a complex forming ligand, or a ligand that forms solid phases with the component.
Calculation is possible only for species derived from one single component (eg. all dissolved
complexes and solid phases for Fe(ll) and Fe(lll) if either Fe** or Fe** is chosen as a component).
All relevant species that are to appear in the diagram must have priority in the
list of species. Species that are solid phases must carry the code '(s)' in their

names, gaseous species the code '(g)', so the program can recognize them.

The option shall be demonstrated with two examples: 1) The calculation of the ps-pH-diagram
for water, and 2) the pe-pH-diagram for the Fe-CO,-system as exemplified in Stumm and Morgan,

Aquatic Chemistry (1981), p. 446.

Example 1: pe-pH-diagram for water

What are the redox boundaries for the existence of water? At what pH and redox potential is H,O

either reduced or oxidized?

The species occurring in the system are: H,O, Hx(g), Ox(g), €', OH’, and H*

Three reactions have to be taken into consideration:
a. the oxidation: 2H,0 < O, + 4e + 4H"* log K =-83
b. the reduction: 2H" + 20 < H, logK=0

c. autocatalysis of water: H,O < H' + OH log K=-14
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The program calculates speciation in the desired steps, searches for the species with the
highest concentration, and compares with the species with the highest concentration found in
the last interval. Gaseous species (whose name must contain the code '(g)') are recognized as
dominating when their partial pressure is at least 1atm, and solid phases '(s)' when their
solubility product is exceeded. Bordering concentrations are calculated by an iterative

procedure converging when the error is smaller than .001.

The abovementioned six species are described with three components (H,0, e, and H*), and
constitute the input matrix. Input concentrations are 55.55 mol/l for water, and any concentration
for e and H*, since these concentrations will be altered by the program according to user inputs
by the pX-pY-dialog. The modes for these two components must be 'free'. (The matrix is 'pXpY-

H20.mat' in the demo folder):

H20 e- H+

total free free
02(g) 2 -4 -4 -83
H2(g) 0 2 2 0
H20 1 0 0 0
e- 0 1 0 0
OH- 0 0 -1 -14
H+ 0 0 1 0

55.55 1e+3 1e-3

Choosing pXpY diagram... from the menu will lead you to the following dialog window:
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[:XeXe pX-p¥ Diagram [
~X-component
H+ 5
-log range from: to:
~Y-component
(e- B
-log range from: to:

plot species: _H20

—

."’—-\.
[ Cancel )

include species from 1 to:

step size: 0.20

Ok

Choose the X and Y component and give the range in negative logarithms (pX = -log X). Choose

pH range 3 to 9 and pe range -10 to +20. The main component that is common to all

species of interest is H,O. Species from 1-3 are to be included in the graphic (i.e. O, (g), H,

(9), H,0). The suggested step size of 0.2 refers to the logarithmic units of both, pX and pY, i.e.

pH and pe.

Filling in the questionnaire, closing, and pressing Go will automatically activate Graphics,

and you will obtain the following diagram:

s

Graphics

alala Data
=log H+ -log e~
9.000  -9.000 H2(g) H20
8.800  -8.800 H2(g) H20
8.800  -8.800 H2(g) Ho 006
8600  -8.600 H2(g) H20 207
8600  -8.600 H2(g) H20
8400  -8.400 H2(g) H20 154
8400  -8.400 H2(g) H20
8200 -8.200 H2(g) H20
8200 -8.200 H2(g) H20 104
8000  -8.000 H2(g) H20
8000  -8.000 H2(g) H20
7.800  -7.800 H2(g) H20 59
7.800  -7.800 H2(g) H20 )
7.600  -7.600 H2(g) H20  §
7.600  -7.600 H2(g) H20 &
7.400  -7.400 H2(g) H20
7.400 -7.400 H2(g) H20 54
7200  -7.200 H2(g) H20
7.200  -7.200 H2(g) H20
7.000  -7.000 H2(g) H20 -104
7.000  -7.000 H2(g) H20
6.800  -6.800 H2(g) H20 154
-20
y ;
0 1

rad
w
s
o
o
~]
@
©
"
S
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Save the calculated points that appeared in the data window by choosing Save data... from

the File menu to use a professional drawing software.

Example 2: pe-pH-diagram for the Fe - CO. - H,O
system

(from Stumm and Morgan, Aquatic Chemistry, 1981, fig. 7.7.)

The various dissolved complexes and solid phases of iron, reduced and oxidized, that prevail
under certain conditions of pH and redox potential are calculated here according to thermo-
dynamic equilibrium constants. It is quite a task to collect all equilibrium constants, and
comparing them with the constants used in Stumm and Morgan or Sigg und Stumm (Aquatische
Chemie, 1994), one will find that these are not consistent throughout the graphs. Small
changes in the solubility products for Fe(OH).(s) and FeCO,4(s) lead to marked differences in the

region of existence for FeCQO; (s).

Reactions relevant to the system and its constants are collected in the following matrix ('|pXpY-

Fe.mat' in the demo folder). Note that the formation of all iron species is formulated with Fe®*:

Fe++ HCO3- e- H+
total total free free
Fe++ 1 0 0 0 0
FeOH+ 1 0 0 -1 -9.5
Fe(OH)2(aq) 1 0 0 -2 -20.6
Fe(OH)3- 1 0 0 -3 -31
Fe(OH)2(s) 1 0 0 -2 -12.1
FeCO3(aq) 1 1 0 -1 -5.6
FeHCO3- 1 1 0 0 2.4
FeCOS3(s) 1 1 0 -1 0.2
Fe(s) 1 0 2 0 -13.8
Fe+++ 1 0 -1 0 -13.0
FeOH++ 1 0 -1 -1 -15.2
Fe(OH)2+ 1 0 -1 -2 -20.2
Fe(OH)4- 1 0 -1 -4 -35.2
Fe(OH)3(s) 1 0 -1 -3 -16.0
H2CO3 0 1 0 1 6.3
HCO3- 0 1 0 0 0
CO3-- 0 1 0 -1 -10.3
e- 0 0 1 0 0
OH- 0 0 0 -1 -14
H+ 0 0 0 1 0

1.0E-51.0E-31.0E+71.0E-7
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The diagram is calculated for a total iron concentration of 10° mol/l and a total bicarbonate
concentration of 10® mol/l. Combined with the data from example 1, the diagram looks as follows

and can easily be completed with a few lines:

20

+
<
14

Fe
15 7]
% o P02 > latm
LY
e
hd o

o
°

10 7]

Fe +2

Fe(OH)j(s)

-log e

pH2 > latm * .

. .I%EC03(S);‘- .

(9]
—_——

The square in the lower right corner was calculated with higher resolution to clearly recognize

the slope of the border between Fe(OH),(s) and Fe(OH),.
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Examples

1. AIll components dissolved, total concentrations given

Complexes of Pb(ll) with EDTA and NTA ex01.mat
Titration curve for Na;PO, with acid ex02.mat
Titration curve for H;PO, with base ex03.mat

2. All components dissolved, free concentrations of some components are given

constant pH: Complexes of Mercury (1l) ex04.mat
constant peo,: Equilibrium with a soda solution ex05.mat
constant free conc. of a species: Metal buffer for Cuz*(aq) ex06.mat

3. Dissolution of one (or more) solid phase

Dissolution diagram of Cu(OH),(s) ex07.mat
The CaCQ,/CO, - system ex08.mat
Dissolution of Ca,Al,0,S0, 12H,0 ex09.mat
Dissolution of several solid phases ex10.mat

4. Precipitation of one (or more) solid phases
Precipitation of PbCO4(s) ex11.mat

5. Adsorption to particulate surfaces
-one particulate surface or one type of surface site respectively
Surface speciation of y-Al,O4in 0.1M NaClO, at pH 7

Constant Capacitance Model ex12.mat
Diffuse Layer Model / Generalized Two Layer Model ex13.mat
Basic Stern Layer Model ex14.mat
Triple Layer Model ex15.mat
Adsorption of lead on goethite ex16.mat

-two or more particulate surface types

Constant Capacitance Model ex17.mat
Diffuse Layer / Generalized Two Layer Model ex18.mat
Basic Stern Layer Model ex19.mat
Triple Layer Model ex20.mat

-Several types of surface sites on one type of particle
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Diffuse Layer / Generalized Two Layer Model
6. pXpY Diagrams
The S(VI), S(0), S(-1l) - System
The Chlorine System

7 . Solubility Diagrams
The Iron - CO, System
The PbCO; - PbSO, System

ex21.mat

ex22.mat

ex23.mat

ex24.mat
ex25.mat
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1. All components dissolved, total
concentrations given

Complexes of Pb(ll) with EDTA and NTA(ex01.mat)

Equilibrium concentrations of all species in a solution made from 10° M Pb(1l), 2:10° MH,EDTA

and 10°MNa,NTA:

Pb++ H4EDTANTA--- H+
total total total total

Pb++ 1 0 0 0 0
PbOH+ 1 0 0 -1 -7.7
Pb(OH)2 1 0 0 -2 -17.1
Pb(OH)3- 1 0 0 -3 -28.1
PbNTA- 1 0 1 0 12.6
PbEDTA-- 1 1 0 -4 -3.96
PbHEDTA- 1 1 0 -3 -0.76
EDTA-—-- 0 1 0 -4 -23.76
HEDTA--- 0 1 0 -3 -12.64
H2EDTA-- 0 1 0 -2 -3.66
H3EDTA- 0 1 0 -1 -2.72
H4AEDTA 0 1 0 0 0
NTA--- 0 0 1 0 0
HNTA-- 0 0 1 1 9.71
H2NTA- 0 0 1 2 12.19
H3NTA 0 0 1 3 13.99
HANTA+ 0 0 1 4 14.79
OH- 0 0 0 -1 -14
H+ 0 0 0 1 0
1e-6 2e-6 1e-5 0

Choose Go from the Run menu...
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Titration of Na,PO, with strong acid (ex02.mat)

Say we want to calculate the Titration of a 10° M solution of Na,P O, with strong acid:

The matrix can be collected from the library. Na+ is omitted since it does not take part in any

reaction.
PO4--- H+

total total
PO4--- 1 0 0
HPO4-- 1 1 12
H2PO4- 1 2 18.8
H3PO4 1 3 20.9
OH- 0 -1 -14
H+ 0 1 0

1e-3 0

Choose Component range from the Option menu. Select H+ (since we titrate with strong
acid) and give a range for the amount of strong acid added per liter, eg. from 0 to 3e-3 in steps of
1e-4. (A remark will follow your attempt to enter a concentration of 0, and it will be changed to a
very small number). If you wish a graphical representation of the titration curve, change the
output format from linear to logarithmic (since we want to see the pH in dependence of acid

added), select the 'H+' species in the Graphic item of the Options menu, and press Go:

conc. range of total H+
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Titration of H,PO, with strong base (ex03.mat)

Calculate a titration curve to the titration of a 10 M solution of H;PO, with strong base! For this

task select a matrix with ‘H3PO4’ and ‘H+’, then choose Replace H+ by OH- from the Matrix

menu. You should obtain:

H3PO4 OH-
total total
PO4--- 1 3
HPO4-- 1 2 19.1
H2PO4- 1 1 11.9
H3PO4 1 0 0
H+ 0 -1 -14
OH- 0 1 0
1e-3 0

Choose Component range under the Option menu and give a range for the amount of OH

added per liter (eg. from 0 to 3-10% in steps of 10™). For graphical representation of the titration
curve (pH vs. base added) choose the 'H+' species in Graphics... and change the format from

linear to logarithmic. The following titration curve should be obtained:

conc. range of total OH-
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2. All components dissolved, free
concentrations of some components given

Constant pH: Complexes of Hg(ll) with hydroxide
and chloride (ex04.mat)

What is the distribution of mercury species in a solution with 10° M Hg(ll), 0.1M CI and pH 8.3 ?

Choose Hg++, Cl-, and H+ as components and put up the matrix:

Hg++ Cl- H+

total total free
Hg++ 1 0 0 0
HgOH+ 1 0 -1 -3.4
Hg(OH)2 1 0 -2 -6.2
Hg(OH)3- 1 0 -3 -21.1
Hg20H+++ 2 0 -1 -3.3
HgCl+ 1 1 0 6.72
HgCI2 1 2 0 13.23
HgCI3- 1 3 0 14.2
HgCl4-2 1 4 0 15.3
Cl- 0 1 0 0
OH- 0 0 -1 -14
H+ 0 0 1 0

-
(1]

©
o

1 5e-9
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Constant pco,: Equilibrium of a soda solution with
atmospheric CO, (ex05.mat)

10 moles of soda (Na,CQ,) are dissolved in one liter of water. A certain pH establishes
immediately. If this solution is left open to the atmosphere it will take up CO, from the air, and the
pH will decrease until a new equilibrium is reached. What is this pH, and how much atmospheric

CO, is taken up by this solution?

Solution: The solution gives up CO, until equilibrium with the atmosphere is reached. If one

COZ turns into CO,, two equivalent OH" remain in the solution according to the reaction:

COZ + H0 < CO, + 20H"

The final solution therefore corresponds to a solution of 2:10* M base that equilibrates with the

atmosphere. This is represented by the following matrix:

C02(g) OH-

free total
H2CO3 1 0 -1.4
HCO3- 1 1 6.3
CO03-- 1 2 10
H+ 0 -1 -14
OH- 0 1 0

3.5e-4 2e-4
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Constant free concentration of a species: Metal
buffer for Cu?* (ex06.mat)

What is the total conc of Cu(ll) in a metal buffer with a free Cu®* concentration of 102 M, a Tris

(aq)

concentration (Tris(hydroxymethyl)aminomethane) of 10* M at pH 7.5?

Cu++ Tris H+
free total free

Cu++ 1 0 0 0
CuOH+ 1 0 -1 -8
Cu(OH)2 1 0 -2 -15.2
Cu(OH)3- 1 0 -3 -26.8
Cu(OH)4-- 1 0 -4 -39.9
Cu2(OH)2++ 2 0 -2 -11
CuTris++ 1 1 0 3.95
Cu(Tris)2++ 1 2 0 7.63
Cu(Tris)3++ 1 3 0 11.1
Cu(Tris)4++ 1 4 0 14.1
CuOHTris+ 1 1 -1 -2.05
(CuOHTris)2++ 2 2 -2 1.9
CuOH(Tris)2+ 1 2 -1 1.31
Cu(OH)2(Tris)2 1 2 -2 -6.59
Tris 0 1 0 0
HTris+ 0 1 1 8.09
OH- 0 0 -1 -14
H+ 0 0 1 0

1e-12 1e-4 3e-8

The total concentration of copper can be read from the bottom part of the data window as the

sum of the 'free conc.' and the amount that had to be added in order to provide the desired

equilibrium situation, 'in or out of system'. -> Cu,,, = 9.60-10" M

Components Mode Initial Canc. In or out of system
Cu++ free 1.000E-12 8.604E-12
Tris total 1.000E-4 e

H+ free 3.162E-8 7.927E-5
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3. Dissolution of one (or more) solid phase(s)

Dissolution diagram of Cu(OH)(s) (ex07.mat)

Calculate the maximum soluble copper in the pH range between 5 and 10 (log conc. vs. pH) if

Cu(OH), is the limiting phase! Use complexes of Cu(ll) with hydroxide, carbonate and nitrate in

pure water in equilibrium with atmospheric pco, of 5-10* atm which contains 0.01 M NO;:

Compile a matrix consisting of NO3-, Cu++, CO2 and H+, then replace Cu++ with Cu(OH)2(s)

using Insert Solid Phase...

NO3- Cu(OH)2 CO2 H+

total solidPhase free free
Cu++ 0 1 0 2 8.68
CuOH+ 0 1 0 1 0.68
Cu(OH)2 0 1 0 0 -6.52
Cu(OH)3- 0 1 0 -1 -18.12
Cu(OH)4-- 0 1 0 -2 -31.22
Cu2(OH)2++ 0 2 0 2 6.36
CuCO3 0 1 1 0 -2.72
Cu(CO3)2-- 0 1 1 -2 -16.83
CuNO3+ 1 1 0 2 9.18
Cu(NO3)2 2 1 0 2 8.28
NO3- 1 0 0 0 0
H2CO3 0 0 1 0 -1.5
HCO3- 0 0 1 -1 -7.82
CO3-- 0 0 1 -2 -18.15
OH- 0 0 0 -1 -14
H+ 0 0 0 1 0

1e-2 1 5e-4 1e-7

To calculate speciation for a pH range, choose pH range in the Options menu, enter the desired
range and step size (e.g. pH 5 to 10 in steps of 0.2 pH units). A logarithmic representation of the

Cu species looks as follows:



ChemEQL Manual

77

(@06

Graphics

1.0E-17]
1.0E-2- .
1.0E-34

1.0E-4+ o @

o
oo

1.0E-54 8

=
=

10664 ¢
1.0E-7 .
1.0E-8-|
1.0E-9-]

1.0E-10-]

1.0E-11-]

1.0E-12

>

1.0E-134 i

[If100L] uoReua U0

1.0E-14
1.0E-154
1.0E-16
1.0E-174
1.0E-16
1.0E-19
1.0E-204 -

108214 "
1.0E-22 |
;

¥k m O

0

-

* 200 ¢

X B 0o

ox

P2

axon -

o

-

o ®Dbe

o

©
=

o > ox

+0O

o r x>

e

o

5.00

pH range

10.00

O PO EE X0

Cu++
CuOH+
Cu(OH)2
Cu{OH)3-
Cu[DH)a—
Cu2(OH)2++
Cuco3
Cu(CO3)2—
CuNO3+
CuNO3)2




ChemEQL Manual

The CaCO,; — CO, system (ex08.mat)

What is the pH and composition of a water which is in equilibrium with calcite, CaCO, and

atmospheric pqo, (10°%% atm) ? How much CO, and CaCQ, dissolve in one liter of pure water?

CaC0O3 CO2 H+
solidPhase free total

Ca++ 1 -1 2 9.7
CaOH+ 1 -1 1 -2.5
CaCO0s3(aq) 1 0 0 -5.3
CaHCO3+ 1 0 1 3.3
H2CO3 0 1 0 -1.5
HCO3- 0 1 -1 -7.8
CO3-- 0 1 -2 -18
OH- 0 0 -1 -14
H+ 0 0 1 0

1.0 3.16e-4 0

pH is 8.265, 4.834-10* mol Calcite and 4.757-10* mol CO, dissolve in the solution until

equilibrium is reached.
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Dissolution of Ca,Al,O0,SO, -12H,0O (ex09.mat)

If Ca,AlLOS O, 12H,0 dissolves congruently, stoichiometric amounts of Ca(ll) and Al(lll) are
released. What are the concentrations of totally dissolved Ca(ll) and Al(lll), and what is the pH of

the solution?

Ca4Al206SO4Al+++ SO4-- H+
solidPhase total total total
Ca++ 0.25 -0.5 -0.25 3 18.6
CaOH+ 0.25 -0.5 -0.25 2 5.75
Al+++ 0 1 0 0 0
AlIOH++ 0 1 0 -1 -5
Al(OH)2+ 0 1 0 -2 -9.3
Al(OH)3 0 1 0 -3 -15
Al(OH)4- 0 1 0 -4 -23
SO4-- 0 0 1 0 0
OH- 0 0 0 -1 -14
H+ 0 0 0 1 0
1 0 0 0

Note that start concentrations are zero for all components except the solid phase. From the data
window you will find the total concentrations by addition of the respective species

concentrations:

Cay = 4.1410°M, Al =2.07-10°M, and the pH = 11.59.
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Dissolution of several solid phases (ex10.mat)

What is the pH and composition of a 10? M solution for NO;” which is in equilibrium with the
carbonate phases of Zn(ll), Cd(ll), Pb(ll), and Cu(ll), and atmospheric pco, (10%° atm) ? Which

solid is the most soluble, which the least soluble?

ZnCO3(s) CdCO3(s)PbCO3(s)CuCO3(s) NO3 CO2(g) H+ {log K}
solidPhase solidPhase solidPhase solidPhase total free total

Zn++ 1 0 0 0 0 -1 2 7.98
ZnOH+ 1 0 0 0 0 -1 1 -0.98
Zn(OH)2 1 0 0 0 0 -1 0 -8.92
Zn(OH)3- 1 0 0 0 0 -1 -1 -20.42
Zn(OH)4-- 1 0 0 0 0 -1 -2 -33.22
ZnCO3(aq) 1 0 0 0 0 0 0 -5.37
ZnNO3+ 1 0 0 0 1 -1 2 8.38
Zn(NO3)2 1 0 0 0 2 -1 2 7.68
Cd++ 0 1 0 0 0 -1 2 4.36
CdOH+ 0 1 0 0 0 -1 1 -5.74
Cd(OH)2 0 1 0 0 0 -1 0 -16.04
Cd(OH)3- 0 1 0 0 0 -1 -1 -28.94
Cd(OH)4-- 0 1 0 0 0 -1 -2 -43.04
CdCO3(aq) O 1 0 0 0 0 0 -9.39
CdNO3+ 0 1 0 0 1 -1 2 4.86
Cd(NO3)2 0 1 0 0 2 -1 2 4.56
Pb++ 0 0 1 0 0 -1 2 4,97
PbOH+ 0 0 1 0 0 -1 1 -2.73
Pb(OH)2 0 0 1 0 0 -1 0 -12.13
Pb(OH)3- 0 0 1 0 0 -1 -1 -23.13
PbCO3(aq) O 0 1 0 0 0 0 -6.13
Pb(C03)2-- 0 0 1 0 0 1 -2 -23.03
PbNO3+ 0 0 1 0 1 -1 2 6.14
Pb(NO3)2 0 0 1 0 2 -1 2 6.37
Cu++ 0 0 0 1 0 -1 2 8.47
CuOH+ 0 0 0 1 0 -1 1 0.47
Cu(OH)2 0 0 0 1 0 -1 0 -6.73
Cu(OH)3- 0 0 0 1 0 -1 -1 -18.33
Cu(OH)4-- 0 0 0 1 0 -1 -2 -31.43
CuCO3(aq) O 0 0 1 0 0 0 -2.88
Cu(CO03)2-- 0 0 0 1 0 1 -2 -17.04
CuNO3+ 0 0 0 1 1 -1 2 8.97
Cu(NO3)2 0 0 0 1 2 -1 2 8.07
H2CO3 0 0 0 0 0 1 0 -1.5
HCO3- 0 0 0 0 0 1 -1 -7.82
CO03-- 0 0 0 0 0 1 -2 -18.15
NO3- 0 0 0 0 1 0 0 0
OH- 0 0 0 0 0 0 -1 -14
H+ 0 0 0 0 0 0 1 0
1 1 1 1 0.01 5E-4 0

result: pH = 7.80, solubility: Cu >Zn > Pb > Cd
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4. Precipitation of one (or more) solid phases

Precipitation of PbCOy(s) (ex11.mat)

Is a solution with 10° M Pb(ll) oversaturated with respect to PbCO4(s) between pH 5o 12 ? The

solution contains 0.01M NO; for ionic strength and is in equilibrium with CO, at pco, = 10 atm.

NO3- PbCO3 CO2 H+

total checkPrecip free free
Pb++ 0 1 -1 2 4.97
PbOH+ 0 1 -1 1 -2.73
Pb(OH)2 0 1 -1 0 -12.13
Pb(OH)3- 0 1 -1 -1 -23.13
Pb2OH+++ 0 2 -2 3 3.54
PbCO3(aq) 0 1 0 0 -6.13
Pb(C03)2-- 0 1 1 -2 -23.03
PbNO3+ 1 1 -1 2 6.14
Pb(NO3)2 2 1 -1 2 6.37
NO3- 1 0 0 0 0
H2CO3 0 0 1 0 -1.5
HCO3- 0 0 1 -1 -7.82
CO03-- 0 0 1 -2 -18.15
OH- 0 0 0 -1 -14
H+ 0 0 0 1 0

1e-2 1e-6 3.16e-4 1e-4

Choose pH range and enter from 5 to 12 in steps of 0.2. A graphical representation of all Pb(ll)

species reveals that precipitation occurs between approx. pH 6 and 11:
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5. Adsorption to particulate surfaces

One particulate surface type

Surface speciation of y-AloO3 in 0.1M NaClO4 at pH 7:

(According to the examples of J. Westall, using four adsorption models).

Constant Capacitance Model

SOH charge H+
adsorbentichargei.1 free

Pb++
PbOH+
Pb(CH)2
PB{CH)3-
Pb2OH+++
PbCO3
Pb(CO3)2—
PBNO3+
Pb{NO3)2

SO- 1 -1 -1 -9.24

SOH 1 0 0 0

SOH2+ 1 1 1 7.4

OH- 0 0 -1 -13.8

H+ 0 0 1 0
1.0 0.0 1e-7

ConstantCap {model}

129 {surface area in m%g}

1.37e-4 {no. of surface sites mol/g}

8.174 {conc. of solid in g/}

0.1 {ionic strenght in M}

1.06 {inner capacitance in F/m?%

(ex12.mat)
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Diffuse Layer Model (ex13.mat)
SOH charge H+
adsorbentichargei1.1 free
SO- 1 -1 -1 -8.98
SOH 1 0 0 0
SOH2+ 1 1 1 7.66
OH- 0 0 -1 -13.8
H+ 0 0 1 0
0 0.0 1e-7

Diffuse/GTL
129

1.28e-4

8.174

0.1

{model}

{surface area in m%g}

{no. of surface sites mol/g}
{conc. of solid in g/lI}

{ionic strenght in M}
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Basic Stern Layer Model (ex14.mat)
SOH 1st ch. 2nd ch. H+
adsorbentichargei.1charge1.2 free
SO- 1 -1 0 -1 -8.46
SOH 1 0 0 0 0
SOH2+ 1 1 0 1 8.16
OH- 0 0 0 -1 -13.8
H+ 0 0 0 1 0
0 -1 -0.5 1e-7
SternL {model}
129 {surface area in m%g}
1.33e-4 {no. of surface sites mol/g}
8.174 {conc. of solid in g/lI}
0.1 {ionic strenght in M}
2.4 {inner capacitance in F/m?
Triple Layer Model (ex15.mat)
SOH 1st ch. 2nd ch. 3rd ch. H+
adsorbentichargei.1chargei.2charge1.3 free
SO-Na+ 1 -1 1 0 -1 -9.31
SOH2+CIl04- 1 1 -1 0 1 7.33
SO- 1 -1 0 0 -1 -9.31
SOH 1 0 0 0 0 0
SOH2+ 1 1 0 0 1 7.33
OH- 0 0 0 0 -1 -13.8
H+ 0 0 0 0 1 0
0 0 0 0 1e-7
TripleL {model}
129 {surface area in m%g}
1.32e-4 {no. of surface sites mol/g}
8.174 {conc. of solid in g/}
0.1 {ionic strenght in M}
1.2 {inner capacitance in F/m?

0.2 {outer capacitance in F/m?}
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Adsorption of Lead on Goethite (ex16.mat)

Pb?* adsorbs on Goethite (a-FeOOH). In order to obtain surface complexation constants for

Pb?* we titrated a solution of 2.4-107 mol/l Pb(ll) with a goethite suspension at pH 7.15 at an
ionic strength of 0.01M KNQO; in a concentration range of 0-50 mg/l Goethite. Calculate the
titration curve Pb,4 vs. Goethite! Use the Generalized Two Layer Model ("Diffuse/GTL"). The

following parameters and constants were experimentally obtained:

specific surface : 14.7 m?g
H+-exchange capacity : 1.35-10* mol/g

Pb++ FeOOH charge H+ {log K}

total adsorbent1 charge1.1 free
Pb++ 1 0 0 0 0
PbOH+ 1 0 0 -1 -7.7
Pb(OH)2 1 0 0 -2 -1741
Pb(OH)3- 1 0 0 -3 -28.1
Pb20OH+3 2 0 0 -1 -6.4
FeOOPb+ 1 1 1 -1 -0.52
(FeO0)2Pb 1 2 0 -2 -5.27
FeOOH2+ 0 1 1 1 6.7
FeOOH 0 1 0 0 0
FeOO- 0 1 -1 -1 -9
OH- 0 0 0 -1 -14
H+ 0 0 0 1 0

2.4e-7 1.0 0.0 7.08e-8
Diffuse/GTL {model}
14.7 {surface area in m*/g}
1.350e-4 {no. of surface sites mol/g}
1e-3 {conc. of solid in g/}
0.01 {ionic strength in mol/l}

Choose Adsorption range... from the Options menu and enter the concentration range
(dimension is g/l, therefore: from 0 to 0.05 in steps of e.g. 0.0025). Choose Graphics... and
select the two surface species. A graphical representation of the titration curve will be calculated
that shows the increasing formation of surface complexes, or inverse if you select dissolved

Pb(ll) species, the disappearing of Pb(ll) from the solution.
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Two or more (up to five) particulate surface types

Constant Capacitance Model (ex17.mat)
AxOH Ch1 BxOH Ch2 CxOH Ch3 H+
adsorbenti adsorbent2 adsorbent3 free
chargei.1 charge2.1 charge3.1
AxO- 1 -1 0 0 0 0 -1 -9.24
AxOH 1 0 0 0 0 0 0 0
AxOH2+ 1 1 0 0 0 0 1 7.4
BxO- 0 0 1 -1 0 0 -1 -9.24
BxOH 0 0 1 0 0 0 0 0
BxOH2+ 0 0 1 1 0 0 7.4
CxO- 0 0 0 0 1 -1 -1 -9.24
CxOH 0 0 0 0 1 0 0 0
CxOH2+ 0 0 0 0 1 1 1 7.4
OH- 0 0 0 0 0 0 -1 -13.8
H+ 1 0 1 0 0 0 1 0
1 0 1 0 1 0 1e-7
ConstantCap {model}
129 129 129 {area}
1.37E-04 1.37E-04 1.37E-04 {surface sites}
8.174 8.174 8.174 {solid conc}
0.1 {ionic strength}
1.06 1.06 1.06 {inner capacitance}

Three identical particles (same as example ex12.mat - ex15.mat) were assumed for the

demonstration of this program option.
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Diffuse Layer Model / General Two Layer Model (ex18.mat)
AOH chA BOH chB COH chC H+
adsorbenti1 adsorbent2 adsorbent3 free
chargel.1 charge2.1 charge3.1
AO- 1 -1 0 0 0 0 -1 -8.98
ACH 1 0 0 0 0 0 0 0
AOH2+ 1 1 0 0 0 0 1 7.66
BO- 0 0 1 -1 0 0 -1 -8.98
BOH 0 0 1 0 0 0 0 0
BOH2+ 0 0 1 1 0 0 1 7.66
CO- 0 0 0 0 1 -1 -1 -8.98
COH 0 0 0 0 1 0 0 0
COH2+ 0 0 0 0 1 1 1 7.66
OH- 0 0 0 0 0 0 -1 -13.8
H+ 0 0 0 0 0 0 1 0
0.0 0.0 0.0 0.0 0.0 0.0 1E-7
Diffuse/GTL {model}
129 129 129 {surface area}
1.28E-04 1.28E-04 1.28E-04 {sites conc}
8.174 8.174 8.174 {conc in g/I}

0.1 {ionic strength}
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Basic Stern Layer Model

AOH ChA1 ChA2 BOH1ChB1ChB2 COH ChC1ChC2 H+

adsorbent1 charge1.2 charge2.1 adsorbent3 charge3.2

chargel.1 adsorbent2 charge2.2 charge3.1

AO- 1 -1
AOH 1 0
AOH2+ 1 1
BO- 0 0
BOH 0 0
BOH2+ 0 0
CO- 0 0
COH 0 0
COH2+ 0 0
OH- 0 0
H+ 0 0
0.0 0.0
SternL
129 129
1.33E-04 1.33E-04
8.174 8.174
0.1
2.4 2.4

[eoNoNe)

oo [eNeoNa) [eNoNe)

0.0 0.0 0.0

129

1.33E-04
8.174

2.4

0
0
0

[eNoNe)

0
0
0

o oo

[eNoNe)

0
0

0.0 0.0 0.0 0.0 1E-7

{model}

{spec. surface m2/g}
{sites conc. in mol/g}
{conc. in g/l}

{ionic strength}

0
0
0

[eNoNe)

0
0
0

[ecNeoNe)

[eNoNe) [eNoNe)

[eNoNe)

0
0

free

{inner capacitance F/m2}

(ex19.mat)

-8.46
8.16
-8.46
8.16
-8.46
8.16

-13.8
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Triple Layer Model (ex20.mat)

AxOHChA1 ChA2ChA3BxOHChB1ChB2ChB3CxOHChC1ChC2 Ch3 H+

adsorbent1 charge1.2 adsorbent2 charge2.2 adsorbent3 charge2.3 free
chargei1.1 charge1.3 charge2.1 charge2.3 charge2.3c harge2.3

AxO-Na+ 1 -1 1 0 0 0 0 0 0 0 0 0 -1 -9.31
AxOH2+CIO4- 1 1 -1 0 0 0 0 0 0 0 0 0 1 7.33
AxO- 1 -1 0 0 0 0 0 0 0 0 0 0 -1 -9.31
AxOH 1 0 0 0 0 0 0 0 0 0 0 0 0 0
AxOH2+ 1 1 0 0 0 0 0 0 0 0 0 0 1 7.33
BxO-Na+ 0 0 0 0 1 -1 1 0 0 0 0 0 -1 -9.31
BxOH2+CIO4- 0 0 0 0 1 1 -1 0 0 0 0 0 1 7.33
BxO- 0 0 0 0 1 -1 0 0 0 0 0 0 -1 -9.31
BxOH 0 0 0 0 1 0 0 0 0 0 0 0 0 0
BxOH2+ 0 0 0 0 1 1 0 0 0 0 0 0 1 7.33
CxO-Na+ 0 0 0 0 0 0 0 0 1 -1 1 0 -1 -9.31
CxOH2+CIO4- 0 0 0 0 0 0 0 0 1 1 -1 0 1 7.33
CxO- 0 0 0 0 0 0 0 0 1 -1 0 0 -1 -9.31
CxOH 0 0 0 0 0 0 0 0 1 0 0 0 0 0
CxOH2+ 0 0 0 0 0 0 0 0 1 1 0 0 1 7.33
OH- 0 0 0 0 0 0 0 0 0 0 0 0 -1 -13.8
H+ 1 0 0 0 0 0 0 0 0 0 0 0 1 0
0 0 0 0 0 0 0 0 0 0 0 0 1le-7
TripleL {model}
129 129 129 {area}
1.32E-04 1.32E-04 1.32E-04 {surface sites}
8.174 8.174 8.174 {solid conc}
0.1 {ionic strength}
1.2 1.2 1.2 {inner capacitance}
0.2 0.2 0.2 {outer capacitance}
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Several types of surface sites on one type of

particle

(Maximum: three different site types and five different particles)

Diffuse Layer Model / General Two Layer Model

strongSitesweakSites

adsorbenti.1adsorbent1.2charge1.1

strong=SO- 1
strong=SOH 1
strong=SOH2+ 1
weak=SO- 0
weak=SOH 0
weak=SOH2+ 0
strong=SOM+ 1
weak=SOM+ 0
M++ 0
OH- 0
H+ 0
0.
Diffuse/GTL
129 129
1.28E-04 2.56E-04
8.174 8.174
0.1

O oo

0.0

charge

0.0

M++

total

O oo

[cNeoNe)

1.0E-6

{surface area in m%’g}

{conc. of surface sites, mol/g}
{solid conc. in g/I}

{ionic strength in mol/l}

H+

free

1.0E-7

(ex21.mat)

-8.98
7.66
-8.98
7.66
-7

-9

-13.8
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6. pe-pH diagrams

The S(VI), §(0), S(-1l) - System (ex22.mat)

fig. 7.5. (Stumm and Morgan, Aquatic Chemistry, 1981)

S04-- e- H+

total free free
S04-- 1 0 0 0
HSO4- 1 0 1 2
S(s) 1 6 8 36.2
H2S 1 8 10 41
HS- 1 8 9 34
e- 0 1 0 0
OH- 0 0 1 -14
H+ 0 0 1 0

1E-2 1E+5 1E-7

Choose pX-pY-diagram from the Options menu and fill in the window:

For a reasonnable range select 'H+' as X-component in the pX range 0 to 11

Select 'e-' as Y-component in the pY range -10 to +10.

The Step Size can be set to eg. 0.5, otherwise the calculation takes much time.

The Main Comp.that the species of interest are derived from is SO4--, and there are the first

5 species to plot.
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The Chlorine System

fig. 7.6. (Stumm and Morgan, Aquatic Chemistry, 1981)

Cl- e-

total free
Cl- 1 0
Cl2(aq) 2 -2
HOCI 1 -2
OClI- 1 -2
e- 0 1
OH- 0 0
H+ 0 0

H+
free

0
0
-1
-2

0
-1
]

0.04 1E-20 1E-5

(ex23.mat)

-47.2
-50.5
-57.8

Choose pX-pY-diagram from the Options menu and fill in the window:

For a good range select 'H+' as X-component in the pX range -2 to 10

Select 'e-' as Y-component in the pY range 20 to 30.

The Step Size can be set to e.g. 0.5, otherwise the calculation takes much time.

The Main Comp. that the species of interest are derived from is Cl-, and there are the first 4

species to plot.
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7. Solubility diagrams

The Iron - CO, System (ex24.mat)

fig. 7.9. (Sigg und Stumm, Aquatische Chemie, 1995, 3dr ed.)

Fe++ HCO3- HS- H+

total total total free
Fe++ 1 0 0 0 0
FeCO3(s) 1 1 0 -1 0.4
Fe(OH)2(s) 1 0 0 -2 -12.9
FeS(s) 1 0 1 -1 4.2
H2CO3 0 1 0 1 6.3
HCO3- 0 1 0 0 0
CO3-- 0 1 0 -1 -10.3
H2S 0 0 1 1 7
HS- 0 0 1 0 0
S-- 0 0 1 -1 -19
OH- 0 0 0 -1 -14
H+ 0 0 0 1 0

1E-6 5E-3 1E-9 1E-7

Choose pX-pY-diagram from the Options menu and fill in the window:

For a reasonnable range select 'H+' as X-component in the pX range 5 to 14

Select 'HS-' as Y-component in the pY range 0 to +10.

The Step Size can be set to a larger number, eg. 0.5

The Main Comp.that the species of interest are derived from is Fe++, and there are the first 4

species to plot.
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The PbCO, - PbSO, system

(ex25.mat)

Which solid, PbCO, or PbSO,, precipitates in a system with lead and various concentrations of

carbonate and sulfate?

Select a matrix with the components Pb++, SO4--, CO3--, and H+ from the library.

Save and move to EXCEL. Add the formation equations for the two solids PbCO3 (s) and

PbCO3(s)
PbS04(s)
Pb++
PbOH+
Pb(OH)2
Pb(OH)3-
Pb20OH+++
Pb3(OH)4++
Pb4(OH)4++++
Pb6(OH)8++++
PbHCO3+
PbCO3
Pb(C0O3)2--
PbS0O4(aq)
Pb(S04)2--
H2CO3
HCO3-
CO3--
SO04--
HSO4-

OH-

H+

Pb++
total

—h

m 0000000 242 MDWN—= — = 4 1

1
w

CO03--
total

—h

m OO0 -2 =-=200N—220000C0CO0DOO0CO =

1
w

S04--
total

-

m OO —-—=-000ON—- 00000000000 —+0

1
w

PbSO04 (s) to the matrix. All together there are now 15 Pb-species:

H+
total

- 00O —-NOO0OOCO =

]
-

o
o

CO3-- and SO4-- as X and Y and enter the concentration range:

13.13
7.79

-7.7
-17.1
-28.1

-23.9
-20.9
-43.6
13.5
6.33
9.66
2.75
1.99
16.68
10.33

1.99
-14

25,0 S&M
25,0 S&M
25,0 S&M
25,0 S&M
25,0 S&M
25,0 S&M
25,0 S&M

25,0 S&M
25,1 S&M
25,0 S&M
25,0 S&M

25,0 S&M

The following graph can be calculated with pX-pY Diagram from the Options menu. Select
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